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1 Overview

The Kodak Scan Station 100 is designed as a walk-up scanner that 
requires minimal user training. The Scan Station 100 is a standalone 
solution requiring no host PC or application software. It works with an 
existing network (Ethernet, 10/100 Base T) and makes use of existing 
network shared services such as TCP/IP, FTP and SMTP in order to 
communicate with other network devices or destinations. The color 
touch screen offers a simple, graphical user interface (GUI) to operate 
the device and direct the output. More than just a scanner, the Kodak 
Scan Station 100 is a robust capture solution that lets you quickly send 
your documents via email, the network, networked printers, USB flash 
drives or fax (optional) with a simple touch. 

This Administrator’s Guide provides the information you need to setup 
and administer the Kodak Scan Station 100, Kodak Scan Station 100 
Plus and the Kodak Scan Station 120EX.

For the purpose of this manual the Kodak Scan Station 100, Kodak 
Scan Station 100 Plus and the Kodak Scan Station 120EX will be 
referred to as Kodak Scan Station 100. Any differences between these 
models will be noted.

Chapter 1, Overview — provides system requirements, general 
information you should know before setting up the Scan Station, and 
instructions for unpacking and setting up the Scan Station.

Chapter 2, Pre-Installation Checklist — it is highly recommended that 
you fill in this Pre-Installation Checklist before you begin setting up the 
Scan Station, as it will save you time and make the setup procedures 
easier.

Chapter 3, Initial Setup and Verification — provides installation and 
setup procedures to get your Scan Station up and running. This chapter 
provides basic procedures for setting the language, IP address, email, 
etc. all the way through saving your configuration settings and verifying 
the Scan Station is operational. When you are using the procedures in 
this chapter, it is suggested that you have the completed Pre-
Installation Checklist available for reference.

Chapter 4, Configuring the Scan Station — once your Scan Station is 
successfully setup, this chapter provides procedures for customizing 
scanner settings (e.g. document type, file type, scan resolution, etc.) 
managing your destination groups, (e.g. email addresses, network 
shares, printers), and creating setting shortcuts and tasks. 
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Chapter 5, Scan Station Administration Specifics — provides 
detailed information regarding configuring your office network to allow 
easy integration of the Scan Station, how to properly configure login 
credentials and general network configuration details.

Chapter 6, Maintenance — provides cleaning and maintenance 
procedures for the Scan Station. 

Chapter 7, Troubleshooting — provides a problem solving chart that 
you should refer to before calling Kodak Support. 

Chapter 8, Glossary — provides descriptions for terms used 
throughout this document.

Supported network 
protocols

The Scan Station 100 plugs directly into an Ethernet-based IP network, 
using a standard RJ45 connection, working independently within the 
following environments:

• Microsoft Windows Server 2000 and Server 2003 (TCP/IP, MS 
sharing, SMTP, FTP, Printing)

• NetWare 3.x and 4.x with MS services for NetWare (TCP/IP, MS 
Sharing, SMTP, FTP)

• Unix/Linux environments (SMTP and FTP only)

NOTE: Your network environment may or may not support all of the 
network protocols mentioned above.

The Scan Station 100 supports sending attached images by email using 
the Simple Mail Transfer Protocol (SMTP) and authenticated SMTP 
protocols. Methods supported for authenticated SMTP include: simple 
password, NTLM and Challenge Response. 

NOTE: Kerberos support is not included at this time. 

Anonymous File Transfer Protocol (FTP) and authenticated FTP are 
also supported, including proxy support. To use either form of 
authenticated FTP (with or without proxy), the FTP configuration will 
need sufficient credentials to access the FTP site. This information 
should be available from your network administrator. 

While the Scan Station 100 can be used in heterogeneous networks 
with SMTP and FTP, printing to network printers and scanning to 
network shared folders requires Microsoft printer drivers and SMB 
(Server Message Block) drive access respectively. When used within a 
Microsoft NT Domain, the Scan Station accesses domain resources 
(shared drives and printers) with a standard domain user account, 
provided by the administrator. When used within a Microsoft workgroup, 
the Scan Station may access workgroup resources (share drives and 
printers) without any login credentials providing workgroup PCs have 
been configured to allow guest access to their shared resources.
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Most of the Scan Station’s features can be successfully used in 
heterogeneous network environments. On the Scan Station, printers 
are accessed via Microsoft printer drivers, which are installed on the 
Scan Station using Microsoft Point-and-Print technology. See the 
section entitled, “Configuring printers” in Chapter 4 for more 
information.

Operating system 
requirements

The Configuration Organizer which is installed on a separate PC, 
requires one of the following operating systems:

• Windows 2000 Service Pack 4 and above

• Windows XP Service Pack 2

Both require Microsoft .Net 2.0 Framework and Microsoft Installer v3.0, 
which will automatically be installed if not detected. 

Dependencies Each of the features of the Scan Station are dependent on the 
presence of the network services shown below.

• Scan to e-mail — to scan and send documents to an email recipient, 
the Scan Station must have access to a SMTP-MIME server. If your 
SMTP server requires authentication before use, you also need to 
supply credentials to the Scan Station. Supported SMTP 
authentication types include: simple passwords, NTLM and 
Challenge Response.

• Scan to shared folder — a Windows 98SE, Windows 2000, 
Windows XP, Windows Server 2000 or Windows Server 2003 based 
computer must publish their shared folder (the Scan Station’s 
destination) on the TCP/IP network, and the Scan Station network 
user must have permissions to access the folder.

• Scan to printer — a printer supported by Windows XP must be 
available on the network.

• Scan to FTP folder — the Scan Station can scan documents and 
send them to an FTP site using either authenticated or anonymous 
FTP and can also deliver files through a network proxy. Both network 
proxy and authenticated FTP require login credentials. 
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Administrative 
configuration and 
setup 

The Configuration Organizer is the center of all Scan Station 
administration. With the Configuration Organizer you can create 
administrative configuration files and user configuration files. Setting up 
the Scan Station requires the creation of an administrative configuration 
file. The Configuration Organizer must first be installed on a separate 
computer to properly setup and configure the Scan Station.

Administrative 
configuration files

Once installed, the Configuration Organizer is used to create an 
administrative configuration file, which is written to a USB flash drive 
(the Scan Station 100 comes with three USB flash drives). To create an 
administrative configuration file, check Administrator on the File menu 
of the Configuration Organizer. The administrative configuration file is 
named KSS100.XML and is written to the flash drive (or any other 
location) as an encrypted file. Because this file is encrypted, it can only 
be decoded and read by the Kodak Scan Station 100 or the 
Configuration Organizer. This file can also be password protected, both 
on the USB flash drive and when it is written to the Scan Station. Once 
the file is written to the USB flash drive, the configuration file can be 
transported and installed on the Scan Station (see the following 
diagram). 

The Scan Station automatically detects the presence of a USB flash 
drive and will search the drive for a KSS100.XML file. If the file is valid, 
the contents are examined for further actions. If the contents of the 
configuration file do not match the exact contents of the configuration 
currently stored on the Scan Station, the administrator will be prompted 
to update the Scan Station with the contents of the configuration file on 
the flash drive. The administrator may or may not choose to update the 
Scan Station at this time.

If the OK button is selected, the administrator will be prompted, through 
a sequence of screens, to allow the configuration of the Scan Station. 

Create the Administrative 
configuration file

Save the configuration file 
to a USB flash drive 

Insert a USB flash drive to 
update the Scan Station
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If the Cancel button is selected, the Scan Station will be placed into 
administrative configuration mode. In this mode, the Scan Station 
automatically displays the Settings mode screen. The administrator can 
scroll through each of the setting groups and make modifications to 
each of the values. Any setting that requires more than a simple 
selection (e.g. a typed entry) will display a virtual keyboard that allows 
the entry of more complex data. 

All changes to the Scan Station settings are saved to the Scan Station 
immediately and requires no further action on the part of the 
administrator. For more information about updating your Scan Station, 
see the section entitled, “Updating your Scan Station” in Chapter 5. 

NOTE: Be careful when using the Scan Station in this mode, as it is 
easy to inadvertently change settings. The Scan Station will 
remain in administrative configuration mode as long as the USB 
flash drive is inserted in the Scan Station. When the flash drive 
is removed, the Scan Station returns to “walk-up” mode and the 
Destinations screen will automatically be displayed.

User configuration files Advanced users can create their own configuration files that contain 
personal scanning preferences. These users can start the 
Configuration Organizer, make the necessary changes to destinations 
and settings and save it on their USB flash drive. The main differences 
between a user and administrative configuration are:

• Only user configuration files can define flash drive folders.

• Only administrative configuration files can define printers.

• Only administrative configuration files can be used to modify the 
default settings on a Scan Station.

Once a user configuration file has been created and stored on a USB 
flash drive, the flash drive can be taken to a Scan Station and inserted 
into the USB port. The Scan Station automatically recognizes the 
presence of the flash drive and loads the settings found in the 
configuration file. Because it is a “User” configuration file, the user will 
not be asked or allowed to make any permanent changes to the Scan 
Station’s configuration. Instead, all of the user’s destinations will appear 
on the Scan Station’s display and will be merged with the default 
destination groups. 

The user’s personal destinations will appear in the top toolbar in the 
same order as the Scan Station’s default groups, except that each of 
the user’s personal groups will appear with a “User” profile image as 
part of the icon background. 

If the user’s personal configuration contains changes to the scanner 
settings (all the values found in “Settings” mode), these settings 
temporarily replace the scanner’s default settings. 

Download from Www.Somanuals.com. All Manuals Search And Download.



1-6 A-61588  July 2008 

When a scan job is complete, the user’s USB flash drive can be 
removed from the Scan Station and the Scan Station display returns to 
the normal state with all of the default settings restored.

NOTE: For more information about configuring your Scan Station refer 
to Chapters 3 and 4. For more information on password 
protection of the configuration file, refer to the section entitled, 
“Securing your Scan Station” in Chapter 5.

User types The Scan Station supports three different user types: Administrative, 
Advanced and Walkup. 

• Administrative users are responsible for setting up and maintaining 
the device. 

• Advanced users create and carry their custom settings on a USB 
flash drive that they can use with the Scan Station to make scanning 
possible with one touch. 

• Walkup users use the device by navigating through the default 
options the administrator has setup. Scanning is very easy but the 
walkup user may not have access to their personal email address 
book or custom scan settings the way an Advanced user does. 

Scan Station security To ensure adequate security, the Scan Station will not read any 
program or file from a USB flash drive, or any other removable USB 
device, other than a valid, encrypted configuration file created by the 
Configuration Organizer and a firmware update file created by Kodak.

The Scan Station uses a firewall and blocks nearly all incoming network 
traffic. It will only respond to an Echo (also known as a ping). 

By design, the underlying operating system is not available to the 
administrator or user. Updates to the operating system and/or the Scan 
Station firmware will be made available on Kodak’s web site (http://
www.kodak.com/go/disupport) as needed.

The administrator can require a user to login before a scan session. For 
more information, see the section entitled, “Configuration options” in 
Chapter 3. 

For more information regarding security, see the section entitled, 
“Securing your Scan Station” in Chapter 5.
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What’s in the box Before you begin open the box and check the contents:

• Kodak Scan Station 100

• Input tray

• Output tray

• Special document feeder

• Power cord bundle

• Feed module

• Portable USB flash drives

• Welcome Folio which includes:
- Installation CD
- Registration sheets
- Printed User’s Guide, English
- Quick Tips Guide
- Quick Installation Guide
- Service Contact sheets
- Miscellaneous flyers
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Unpacking and 
setting up the Scan 
Station

Carefully unpack the Scan Station 100 and place it on a clean, dry and 
level surface. Locate and attach the power cord, network cable and the 
input and output trays. Make sure the Scan Station cover is closed. 

Installing the power cord 1. Select the appropriate AC power cord.

2. Plug one end of the power cord into the Scan Station.

3. Plug the other end of the power cord into the wall outlet. 

Installing the network cable 1. Select a (customer provided) 10/100 Base T drop cable.

2. Plug one end of the network cable into the network port of the Scan 
Station located on the back of the scanner.

3. Plug the other end of the network cable into the network drop’s wall 
outlet. 

Attaching the input tray 1. Locate the input tray slots on the Scan Station.

2. Align the input tray pins with the slots.

3. Push down on the input tray until it snaps into place.
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Attaching the output tray 
and special document 
feeder

1. Locate the output tray holes on the Scan Station.

2. Insert the pin on the left side of the output tray/special document 
feeder in the hole, then press the ribbed button on the right side of 
the output tray/special document feeder and insert the pin in the 
hole on the right side of the Scan Station. 

Powering up the Scan 
Station

Turn the power on and wait a few moments while the device completes 
it’s self tests. 

The Scan Station is now ready to have a configuration file downloaded. 
See Chapter 3, Initial Setup and Verification and Chapter 4, Configuring 
the Scan Station, for information on setting up the Scan Station and 
how create and download configuration files.
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2 Pre-installation Checklist

It is recommended that you fill out this worksheet before installing the Kodak Scan Station 100. You will 
need this information about your network to create an administrative configuration for your Scan Station 
using the Configuration Organizer (provided with the Scan Station) and to complete the installation. 
Research any information you are unsure of before creating the administrative configuration file. If you 
have trouble filling out this worksheet, see the person who manages your network.

NOTE: This installation shows what you will need to install the Scan Station as of the date of this 
document. As we improve our products from time to time, check the Kodak website 
(http://www.Kodak.com/go/disupport) for the latest version. 

Language Settings — found under the Settings button in the Configuration Organizer or 
Administration GUI.

Parameter Name Description/Sample Your Setting Notes
Language Name of GUI/OCR language Default: English.

Device Settings — found under the Settings button in the Configuration Organizer or 
Administration GUI.

Parameter Name Description/Sample Your Setting Notes
Device Name NETBIOS name of the Scan 

Station. The default is the Scan 
Station’s unique serial number 
(e.g., KSSXXXX-XXXX, where 
X=the serial number)

It is recommended that you do not 
change this setting. Must be unique 
(up to 15 characters) on the network/
subnet. You can leave this field 
unchanged as ”Scan-Station”  to 
avoid overwriting an existing device 
name. See Chapter 5, Scan Station 
Administration Specifics for more 
information.

IP Address Settings — Automatic
Automatic (DHCP) This is the default. If selected, the IP address, subnet 

mask, and DNS server of the Scan 
Station are set automatically by the 
DHCP server.

IP Address Settings — Static
Static (IPv4)

• IP Address

Standard IPv4 address 
(e.g., 192.0.0.1)
Scan Station’s IP address

Complete this and the other 
network sections only if you are 
not using DHCP.

• Subnet Mask Scan Station’s Subnet Mask (e.g., 
255.255.255.0)

Only these numbers are allowed: 0, 
128, 192, 224, 248, 252, 254 and 255.

• Default Gateway IP of default gateway on the 
network

 

• Preferred DNS 
Server

IP of domain name Server #1 If this number is incorrect, you may 
not be able to reach some network 
locations.

• Alternate DNS 
Server

IP of the alternate domain name 
Server #2

• Preferred WINS 
Server

IP of Windows Internet Name 
Server #1
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Device Settings (continued) — found under the Settings button in the Configuration 
Organizer or Administration GUI.

Parameter Name Description/Sample Your Setting Notes
• Alternate WINS 

Server
IP of Windows Internet Name 
Server #2

Device Password Optional numeric password to 
restrict access to the Scan Station. 
4 digits (e.g. 1234).

Entered via the virtual keyboard at 
each access.

Network User Name Account on the Microsoft Server 
2000 or Server 2003 domain the 
Scan Station uses for access to the 
network driver and printers.

Novell eDirectory and Linux/Unix are 
not supported for login at this time. 
This is required to access shared 
folders and network printers.

Network Password Domain password for network user 
name (e.g., 1Df4781).

Must be a valid Microsoft format.

Network Domain Name of Microsoft Server 2000 or 
Server 2003 domain the network 
user name belongs to (e.g., 
Mycompany).

This is not necessarily the same as an 
Internet domain (company.com). For 
more on domain naming conventions, 
see http://support.microsoft.com/kb/
909264/en-us.
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Email Server Settings — found under the Settings button in the Configuration Organizer or 
Administration GUI.

Parameter Name Description/Sample Your Setting Notes
SMTP Settings

• Server Address Fully qualified domain name or 
IPv4 address of the SMTP server 
(e.g., smtp-server.
company.com or 192.0.0.1).

Use IPv4 to eliminate any DNS issues 
when troubleshooting.

• Credentials User name, password and network 
domain. Required to access the 
SMTP server. 

Required for authenticated SMTP.
NOTE: This is not necessarily the 
same as the credentials defined 
under Device Settings.

• Port Default: 25 Only change if your email server 
communicates on an IP port that is 
not Port 25.

• SSL Secure Socket Layer Typically unchecked. Check only if 
you are sure your email server 
requires it. 

LDAP Settings

• Server Address Fully qualified domain name or 
IPv4 address of the LDAP server 
(e.g., ldap-server.
company.com or 192.0.0.1).

Use IPv4 to eliminate any DNS issues 
when troubleshooting.

• Credentials User name, password and network 
domain. Required to access the 
LDAP server. 

Required for authenticated LDAP.
NOTE: This is not necessarily the 
same as the credentials defined 
under Device Settings.

• Port Default: 389 Only change if your LDAP server 
communicates on an IP port that is 
not Port 389.

• Base DN Base Distinguished Name Contact your corporate LAN 
administrator for more details on this 
setting. 

• Common Name 
Tag

Default: cn Contact your corporate LAN 
administrator for more details on this 
setting.

• Email Address 
Tag

Default: email Contact your corporate LAN 
administrator for more details on this 
setting.

Return Email 
Address

This is the address that bounced 
emails are returned to (e.g., 
bounce@company.com). This 
address will also appear as the 
“From” address when sending 
email. 

Select a person who will receive 
notification that an email address 
could not be reached.

Maximum 
Attachment Size

1-99 MB
Default: 10 MB

Email operations that create files 
larger than this will fail. This should 
match the limitations defined by 
your email server.

Custom Email 
Addresses

Enables/disables the custom Email 
address option, allowing the entry 
of email addresses that do not 
appear in your address book.

Typically enabled; may be disabled in 
more secure environments.
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3 Initial Setup and Verification

This chapter provides instructions for installing the Configuration 
Organizer and procedures for setting up your Scan Station to work 
properly on your office network. Before you begin, you need to know 
some basic information about your network configuration as well as 
network addresses (e.g., your Email server and any shared folders you 
may want to access from your Scan Station). Refer to the Pre-
Installation Checklist in Chapter 2 as you are configuring your Scan 
Station.

Installing the 
Configuration 
Organizer

1. Insert the CD. The installation software starts up automatically.

NOTE: If .NET Framework 2.0 and MSI 3.x is not already installed, 
the Configuration Organizer installer will install them before 
installing the Configuration Organizer application.

2. Click Next. The Welcome screen will be displayed.
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3. Click Next. The License Agreement screen will be displayed.

4. Read the license agreement, click I Agree and then click Next. The 
Select Installation Folder screen will be displayed.

5. Enter, or browse to, the folder where you want to install the 
Configuration Organizer or keep the default setting. You may also 
install the application for Everyone or Just Me (yourself), then click 
Next.
NOTE: It is recommended that you accept the default settings.
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The Confirm Installation screen will be displayed.

6. Click Next. The installation will start and progress will be displayed.
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7. When the installation is complete, the Installation Complete screen 
will be displayed. 

8. Click Close.

Installing the optional 
fax modem

To install the optional Kodak Scan Station Fax Modem Accessory
(CAT No. 128 0528):

NOTES:

• Before installing the optional fax modem accessory, verify that you 
are running Version 2.0 or greater. Go to www.kodak.com/go/
disupport for more information about updating.

• The Kodak Scan Station Fax Modem Accessory is only available on 
the Scan Station 100 and Scan station 100 Plus with serial numbers 
higher than (or equal to): 45325000 and Scan Station 120EX’s with 
serial numbers higher than (or equal to) 45334500.

1. Plug in the standard RJ-11 phone line into the phone connector port 
on the front of the modem. Be sure the other end of the phone line is 
connected to your fax line outlet.

2. Plug in the USB connector to the back of the modem. 

3. Plug the other end of the USB connector into the back of the Scan 
Station.

NOTE: The USB connectors on the back of the Scan Station may 
be covered by a black rubber plug. Remove this plug to 
expose the two USB ports (located below the ethernet 
port).
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Configuring your 
Scan Station

This section provides procedures for configuring your Scan Station to 
connect to your office network environment. You will need to enter 
network-specific settings. This information should already be filled in on 
the Pre-installation Checklist in Chapter 2.

NOTE: Using the PC keyboard to enter information is faster than 
clicking letters and numbers on the virtual keyboard/keypad.

1. Double-click the Configuration Organizer icon on your desktop to 
launch the application. Because you are setting up the Scan Station, 
select the Administrator option under the File menu.

2. Click the Settings button to display the Configuration screen.
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Password protecting the 
configuration file

As an administrator, you want to password protect the configuration file 
from being inadvertently overwritten. Other users who have access to 
the Configuration Organizer can create an Administrator version of a 
configuration file and without knowing it, replace the Scan Station 
settings with their own. If you password protect the configuration file, 
then only an administrator who knows the password can overwrite the 
settings on the Scan Station. 

To password protect your configuration file:

1. Select User>Configuration Password. The Configuration 
Password dialog box will be displayed.

2. Enter a New password (up to 4 digits).

3. Enter the password again to confirm it.

4. Click OK.

NOTE: After applying the configuration file to the Scan Station, 
future attempts to modify the configuration file will require 
the entry of this password. If you lose or forget this 
password, you will need to contact Kodak service to unlock 
your Scan Station and provide the latest KSS100.XML file.
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Language setting The language you select will be used to configure the Scan Station’s 
user interface as well as the language that will be used for the Optical 
Character Recognition function (e.g., when creating a searchable PDF 
file). 

• Click the desired language.
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Device settings The Device icon displays a list of settings which will be used to 
configure the Scan Station to work on your office network. 

1. Click the Device icon.

2. Enter a device name that is not already assigned to a device on 
your office network. Your Device Name must be unique. If you 
attempt to enter a name that already exists on your office network, a 
warning message will be displayed, and, as a result, one of the 
devices will be removed from the network. When finished, click 
Done on the keyboard.

NOTE: The Scan Station is configured with a unique device name. 
If you do not want to change this device name, leave this 
field unchanged with the default information called “Scan-
Station”. 
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3. Select IP Address to configure the device’s network address. 
Select one of the following:

• If your network uses dynamic IP addresses, click Automatic 
(DHCP), and proceed to the next section, “E-mail settings”.

• If your network uses static IP addresses, click Static (IPv4) and 
continue with Step 3.

• If all the static IP Address options are not displayed, use the up 
and down arrows. 

• All of the options on the Static IP Address screen will display a 
keyboard/keypad for entering information. When finished making 
an entry in the following fields, click Done on the keyboard/
keypad to accept the values and close the screen.

- Click IP Address and enter the address.
- Click Subnet Mask and enter the mask.
- Click Default Gateway and enter the gateway address.
- Click Preferred DNS Server and enter the server address.
- Click Alternate DNS Server and enter the server address.
- Click Preferred WINS Server and enter the server address.
- Click Alternate WINS Server and enter the server address.

NOTE: Configuring the DNS and WINS servers may not be 
required.
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4. If you want to protect access to the Scan Station with a password, 
select Device/Administrator Password to display the keypad. 
Enter a 32-character alphanumeric password. You will be asked to 
re-enter the password. When finished, click Done.

NOTES:

• If you assign a device password, all users will be prompted to enter 
this password every time they use the Scan Station. This does not 
take the place of password protecting your Scan Station’s 
configuration file.

• If Force User Login is enabled, this password will be used as the 
administrator account password.

5. Click Default Credentials to define the Username, Password, and 
Domain required to access network resources.

• Click Username to display the keyboard. Enter the network user 
name assigned to the Scan Station’s computer and click Done. 
For more information see the section entitled, “Network 
Configuration details“ in Chapter 5.

NOTE: If you want the Scan Station to have access to network 
printers or network shared folders, the user name must be 
associated with a network account that has sufficient 
privileges to access these resources.

• Click Password to enter the password for the network user 
name. You will be asked to re-enter the password. When finished, 
click Done.

NOTE: This password is only used by the Scan Station and it will 
never be displayed in readable form.

• Click Domain. Enter the Microsoft NT network domain name 
which the Scan Station will be connected to. In a workgroup 
environment, this field can be left blank.
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6. Click Remote Configuration to allow your Scan Station to be 
remotely configured. Refer to the section entitled “Updating your 
Scan Station” (Method 3) in Chapter 5 for more information. When 
selected, the Remote Configuration Settings screen will be 
displayed. 

- Enter a network folder where the Scan Station will find updated 
configuration settings. 

- Select which days of the week and time of day this operation will 
be performed.

- Select the time of day you want your Scan Station to check for 
updates.

7. Click Done.
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E-mail settings For the Scan Station to send documents to email recipients, you must 
define how the Scan Station will access your email server. 

• Click the E-mail icon. The E-mail settings will be displayed.

You can set the SMTP Settings, LDAP Settings, Return Email Address, 
and the Maximum Attachment Size from the E-mail screen. Refer to the 
sections that follow for detailed information and procedures.

SMTP settings 1. From the E-mail screen, click the SMTP Settings option. The 
following screen will be displayed.

2. Select the SMTP Server Address. The virtual keyboard is 
displayed allowing you to enter information. You can enter either a 
fully qualified domain name (e.g., mailserver.mycompany.com) or 
an IP address. When finished entering the SMTP Server Address, 
click Done.
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3. Select Credentials to define the email server credentials. 

NOTE: If you are using an unauthenticated SMTP server, you do 
not need to make any selections in the Credentials fields. 

The Credentials screen will be displayed.

Enter a Username, Password and an optional Domain name for 
the email server account that the Scan Station will log into. Even 
though these credentials may be the same as the Default 
Credentials, they must still be defined here.

For each of these settings the virtual keyboard will be displayed. 
When finished, click Done. 
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4. Most email servers communicate on Port 25. If your email server 
communicates on a different port, click on Port.

The virtual keyboard will be displayed where you can enter a new 
port number. When finished, click Done.

5. The default for SSL is Do not use SSL. If your email server requires 
Secure Socket Layer (SSL), click SSL and enable the Use SSL 
option, then click Done to return to the E-mail screen. 
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6. Click Authentication Scheme to select the specific SMTP 
Authentication Scheme used by your mail server. 

Select from the following options:

• Use Strongest
• None
• Plain
• Login
• MDS Challenge Response
• NTLM

NOTE: Use Strongest will select the strongest available 
authentication scheme reported by the mail server. For 
more information on authentication schemes, consult your 
network administrator.
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7. When your SMTP connection is configured, use the Test 
Connection option to test whether your settings are correct. The 
Scan Station will test your settings and will display a “Success” or 
“Failed” message. If the test connection failed, verify that all of your 
settings are correct and make any necessary changes, until a 
Success message is displayed.

After running the test connection, click OK on the message box to 
return to the SMTP Setting screen. Then click Done to return to the 
E-mail screen.
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LDAP settings Connecting to an LDAP server allows the Scan Station and the 
Configuration Organizer Software to connect to a network address 
directory. This connection can be used to import one or more email 
addresses into an email address group. It can also be used to look up 
addresses on the Scan Station to temporarily add an email address to a 
group list.

1. From the E-mail screen, click the LDAP Settings option. The LDAP 
Settings screen will be displayed.

2. Select the LDAP Server Address. The virtual keyboard is 
displayed allowing you to enter information. You can enter either a 
fully qualified domain name (e.g., directoryserver.mycompany.com) 
or an IP address. When finished entering the LDAP Server Address, 
click Done. 

3. Define the LDAP Credentials. 
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The Credentials screen will be displayed.

Provide a Username, Password and an optional Domain name for 
the LDAP server account that the Scan Station will log into. Even 
though these credentials may be the same as the Default 
Credentials, they must still be defined here.

For each of these settings the virtual keyboard will be displayed. 
When finished, click Done. 

4. Most LDAP servers communicate on Port 389. If your LDAP server 
communicates on a different port, click on Port.

The virtual keyboard will be displayed where you can enter a new 
port number. When finished, click Done.
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5. The Base DN (Distinguished Name), Search Field Tag, Email 
Address Tag, and Full Name Field Tag are strings that define the 
search criteria for the LDAP server. See your network administrator 
for the specific format of these strings. When you have the correct 
format, enter the Base DN, the Search Field Tag, Email Address 
Tag and Full Name Field Tag. 

6. Select Search Results To Return to set the maximum number of 
records to display when performing a search. Select a number from 
1 to 1000. 

7. Click Done.When your LDAP connection is configured, use the Test 
Connection option to test whether your settings are correct. The 
Scan Station will test your settings and will display a “Success” or 
“Failed” message. If the test connection failed, verify that all of your 
settings are correct and make any necessary changes, until a 
Success message is displayed

After running the test connection, click OK on the message box to 
return to the LDAP Setting screen. Then click Done to return to the 
E-mail screen.
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Return Email Address Setting the Return E-mail Address allows you to receive notification if 
an email or fax sent by the Scan Station could not be delivered. This 
address is also used as the “From” email address when sending 
documents via email.

IMPORTANT: Be careful about setting this option as every 
undeliverable email and/or fax notification will be sent to 
this address and the same address will appear as the 
Sender address for every email sent from the Scan 
Station.

NOTE:  If fax service is available, it is suggested that you configure the 
Device Email Address to ensure you are capturing 
unsuccessful fax transaction. The E-mail Fax function of sendng 
notification will not work with fax if there is no SMTP e-mail 
services or server set up 
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Maximum Attachment Size This option allows you to set the maximum size of an email attachment 
that can be successfully sent. This value should match the limitations 
defined by your email server. 

8. Click Maximum Attachment Size. 

The following screen will be displayed.

9. Select the size (0 to 99 MB in 1 MB increments) using the up and 
down arrows, then click the green button to the left of the selected 
number. When you have made your selection, the E-mail screen will 
be redisplayed. 
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Fax settings You must have the optional fax modem accessory fCAT No. 128 0528) 
for the Scan Station 100 and it must be properly connected before 
configuring fax settings. For instructions on installing the fax modem, 
see the section entitled, “Installing the optional fax modem” earlier in 
this chapter.

1. Click the Fax icon. The Fax screen will be displayed.

2. From the Fax screen, click the LDAP Fax Field Tag option. The 
virtual keyboard will be displayed allowing you to enter information. 
Enter the LDAP Fax Field Tag for the tag to use when searching 
LDAP for fax numbers. For more information, contact your network 
administrator for the exact string to use (e.g., faxnumber). When 
finished entering the LDAP Fax Field Tag, click Done.

NOTES:
• LDAP may be used to search for fax numbers that are stored on 

a corporate address book. LDAP is not required to use the fax 
option. 

• The Sender’s FAX Number is informational and can also contain 
text information. This field may be left blank. 

• LDAP credentials for E-mail LDAP must be set up to propertly 
use LDAP for faxing. For more information refer to the section 
entitled, “LDAP settings” earlier in this chapter.
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3. If desired, select Sender’s Fax Number from the Fax screen to 
enter the sender’s fax number. 

The virtual keyboard will be displayed allowing you to enter a 
number. Click Done when finished.

4. Select Outside Line Prefix to enter the desired prefix that the user 
needs to enter to access an outside line.

When selected, the virtual keyboard will be displayed. Enter the 
number you want the user to enter to access an outside line (e.g., 9, 
is frequently used and a comma “,” may be used to insert a pause). 
Each comma pauses the dialing sequence for about 3 seconds. You 
can use multiple commas to increase the pause time. When 
finished, click Done.

5. Select Modem Country Code to display a list of countries and the 
associated codes that configure the modem for use in the selected 
country. 
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6. Select the desired country/code and click Done.

7. Select Incoming Fax Settings to display the Incoming Fax Settings 
screen. If you want to configure your Scan Station to receive faxes, 
the following settings can be used to define where incoming faxes 
will be delivered. You can select a network folder and/or a network 
printer for fax delivery.    

8. If you want to select a network folder to receive incoming faxes, 
select Incoming Fax Folder to display the virtual keyboard.
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9. Enter a fully qualified path name to a network folder where incoming 
faxes will be delivered. 

10.When finished, click Done.

11. If you want to select a network printer for incoming fax delivery, click 
Incoming Fax Printer to display the list of installed printers. 

NOTES:

• If no printers are installed, None will be displayed on the Select 
Printer for Incoming Fax screen.

• Do not delete a printer destination that is assigned to incoming 
faxes. If the incoming fax printer destination is deleted, a 
message will be sent to the administrator’s Email ID.

• To install a printer, refer to the section entitled, “Configuring 
printers” in Chapter 4. 
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12.Select a printer from the list and click Done to return to the Incoming 
Fax Settings screen. 

13.Click Receive Fax to allow faxes to be received at the configured 
device.

NOTES: 

• The Incoming Fax option is only available if the administrator’s Email 
ID is configured (see the section entitled, “Return Email Address” 
earlier in this chapter). If the Email ID is not configured, the following 
message will be displayed: Before Incoming FAX can be enabled, 
you must provide a return E-mail address. Please refer to 
Settings>E-mail>Return E-mail Address and define a valid 
return E-mail address.   

If for some reason the Email ID is removed after you configure the 
incoming fax or the Email ID is invalid, there may be some loss of 
data. 

• If the destination(s) (e.g. printer and/or network folder) have not been 
configured correctly, fax error email(s) will be sent to the Email ID you 
provided for every incoming fax. 

• Receive Fax must be configured after connecting the fax modem.

• If a fax is processed to any of the destinations or an error email is 
sent, it is deleted from the queue and logged as “successful”. 
Destination failures will also be logged.

• All corrupt fax(es) will result in an email to you (the administrator) and 
deleted from the fax queue.

• If the user’s credentials are not configured correctly, the Scan Station 
will make multiple attempts. The user could be locked out because of 
multiple network access errors.

• If there are incorrect configurations for the printer or output folders, or 
if both the configurations are missing, then incoming fax messages 
will stay in the fax queue and require you to update the Scan Station 
to process the faxes.
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Outgoing faxes Three attempts will be made to send a fax. These attempts will be 
made at intervals of 3 minutes each. 

If the fax service is not able to send a fax to the recipient, an email will 
be sent to the sender (User Email Address) if that email address is 
available. Otherwise, the message will be sent to administrator’s email 
address. Included in the message will be: the fax TIFF image, the 
sender and recipient’s fax number and the error response from the MS 
Fax Service.
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Transaction Log settings The Scan Station can log all transactions to a separate transaction file. 
This file is in XML format and can be exported from the Scan Station. 
This is useful in environments that are security-minded or where 
transactions are used for billing. By default, all transactions are logged 
(checked). You can disable logging on any or all of the transaction 
types listed on the Transaction Log Settings screen by unchecking the 
appropriate box. 

1. Click the Transaction Log Setting icon to display the following 
screen.

2. Check or uncheck any or all of the destination types you want to log.

NOTE: If you want to save these files, refer to the section entitled, 
“Saving error log files” in Chapter 7.
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Time settings 1. Click the Time icon. The Time screen will be displayed. 

2. Click Time Zone and select your time zone.

3. Click Daylight Savings and select Automatically Adjust or No 
Adjustment.

4. Click Clock and select either a 12 Hour or 24 Hour time format.

5. Click Separator and select the separator symbol.

6. Click Format and select the hours, minutes, and seconds format.
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Setting the Scan Station 
clock

The time clock on the Scan Station can only be set when the Scan 
Station is in local Administrative mode. 

To set the time clock on the Scan Station:

1. Insert a flash drive with an administrative configuration file into the 
Scan Station.

2. If prompted to update the Scan Station settings, press the No button 
on the control panel. The scanner will now be in Settings mode.

3. Use the arrows to scroll to the Time settings icon.

4. Click on the Set option to display the Time Entry keypad.

5. Enter the time for the Scan Station and click Done.

NOTE: Time is entered in 24-hour mode.
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Date settings If the Calendar icon is not displayed, use the arrows on the toolbar at 
the top of the Configuration Organizer screen to view the Calendar 
icon.

1. Click the Date icon. The Date settings will be displayed.

2. Click Separator and select the desired separator symbol.

3. Click Format and select the desired day, month, year format.
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Setting the Scan Station 
date

The date on the Scan Station can only be set when the Scan Station is 
in local Administrative mode. 

To set the date on the Scan Station:

1. Insert a flash drive with an administrative configuration file into the 
Scan Station.

2. If prompted to update the Scan Station settings, press the No button 
on the control panel. The scanner will now be in Settings mode.

3. Use the arrows to scroll to the Date settings icon.

4. Click on the Set option to display the Date Entry keypad.

5. Enter the date for the Scan Station and click Done.
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Configuration options The Configuration Options screen provides a variety of options.
To access the Configuration Options screen:
• Click the Configuration options icon

QWERTY keyboard By default, the Scan Station will display the virtual keyboard in 
QWERTY format. You may optionally select an alphabetically-sorted 
keyboard format, by deselecting the QWERTY Keyboard option.

Allow custom Email 
Addresses

The Allow custom E-mail Addresses option allows a walk-up user to 
enter an email address that is not currently in the address book. By 
selecting Allow custom E-mail Addresses (this is the default), users 
can enter new email addresses in an ad-hoc manner. Email addresses 
are added temporarily to the currently selected list and will be removed 
at the end of the users scan session.

Allow File Naming File Naming is a feature that allows a user to name both the folder and 
the file name prefix used when scanning to either a network folder or a 
USB flash drive. The folder will be appended to the path of the selected 
destination and the file name will be used to create the actual file. The 
user will optionally be able to turn on or off the date and time stamp 
used when creating the file name. Unchecking this option will disable 
the file naming feature. 

Allow Saving to Flash Drive This feature allows an administrator to disable scanning to a USB flash 
drive. This may be useful in more secure environments where tighter 
control is required.
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Allow Force User Login When enabled, this option requires the user to login before a scan 
session. 

When this option is enabled, the user will be presented with a Login 
screen at the Scan Station requiring the user to enter a user name, 
password and domain. When Force User Login checked, you must 
apply LDAP settings. See the section entitled “LDAP Settings” earlier in 
this chapter. 

A default Administrator account is available for logging onto the Scan 
Station after enabling Force User Login. Initially the password will be 
“blank” and is up to you to set this password to prevent user access to 
Administrative functions. For more information refer to the device 
password option in the section entitled “Device Settings”.
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Allow Adding Pages to a 
Scan Job

When this option is enabled, the user can continue to add pages to a 
scan job. After all pages in the input tray have been scanned, a 
message will be displayed asking if they want to add more pages. If the 
user selects Yes, the additional pages will be scanned and the 
message will be displayed again until the user selects No, or the 30-
second timeout has occurred.

Hide Network Folder 
Location

This option is available if you want to provide a more secure 
environment by partially hiding the location of the network folder. If this 
option is enabled, only the end of the network folder path will be 
displayed on the Scan Station touchscreen. For example: 
\\server\myfolder will be displayed as: ...\myfolder.

Allow FAST Scanning To allow a user to scan instantly without waiting for the 10-second delay 
and the Settings Review screen to be displayed, enable the FAST 
Scanning option. 

A message will only be displayed if the scan session was unsuccessful. 
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Saving your 
configuration

After configuring your Scan Station, save your configuration settings. 
Be sure to insert your USB flash drive into the USB port on your PC 
after the Configuration Organizer is running. This will allow the 
Configuration Organizer to recognize the presence of the flash drive. If 
the flash drive is inserted before the application is launched, the flash 
drive option will not be available on the Save Configuration To dialog 
box. 

1. Click the Save to USB flash drive icon at the top of the screen to 
save the configuration file. 

The Save Configuration To dialog box will be displayed. By default 
the Local backup option is selected. If you choose to create a local 
backup, a copy of the settings will be saved in the same directory as 
the Configuration Organizer.

2. Select where you want to save the configuration settings and click 
Save.

NOTES:

• If the flash drive was inserted before the application is launched, 
remove the flash drive and re-insert it.

• If Remote Configuration is enabled, check the Folder option 
and Browse to the network location where configuration files are 
stored.

• If all three options are selected, the configuration file will be 
saved to three different locations at the same time. 
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Updating your Scan 
Station settings

When you have saved your administrative configuration on your flash 
drive, you can take these settings to a Scan Station and update the 
Scan Station.

1. Insert your USB flash drive in the USB port on the Scan Station.

2. If the Scan Station configuration previously had a password 
assigned to it, you will be prompted to enter that password before 
proceeding with any changes. 

If the configuration settings on the USB flash drive are different than 
those found on the Scan Station, the following screen will be 
displayed.

3. Click Yes. The Select Settings To Replace screen will be displayed.

4. By default, all listed settings will be selected for update; therefore, 
unselect the setting(s) you do not want to update. Use the arrows to 
scroll through the list to display additional settings. 

5. Click Update. 
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NOTES:

• If there are additional settings on the Scan Station (e.g. email are 
new settings on the flash drive that are not on the Scan Station, 
you will be prompted to either add or remove these settings. 

• If you do not want to change settings at this time, click Skip.

• At this point, you have either skipped or saved your settings. The 
Scan Station will now be in “local administrator” mode. 

Any changes made to any of the settings while in “local 
administrator” mode will be saved immediately to the Scan Station. 
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Verifying your Scan 
Station setup

The following steps help you to verify that your Scan Station installation 
was successful and is operational.

1. Insert a blank flash drive in the Scan Station’s USB port.

When the Scan Station recognizes the flash drive, an icon is 
displayed showing the flash drive with the user profile. 

2. Click Save to Flash Drive. 

3. Place a document into the input tray and press the green Go button. 
The Destination Review screen will be displayed.

NOTE: If you enabled FAST Scanning, the Scan Station will start 
automatically and the Settings Review screen will not be 
displayed. Otherwise, the Scan Station will begin scanning 
after 10 seconds (or you can press the green Go button 
again to start scanning immediately).

As the Scan Station begins to feed and process documents, a 
Status screen will be displayed. The page number and a preview 
image will be displayed as each page is being scanned. 
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When the document has been scanned, the Status screen will be 
displayed as it sends your document to each selected destination.

When all destinations have been processed, the following screen 
will be displayed.

NOTE: This screen will list all the destinations you have selected (if you 
had more than one). Successful destinations will be shown with 
a green check mark. Unsuccessful destinations will be shown 
with a red X, and the message, One or more saved 
destinations failed will be displayed. To review detailed error 
messages, download the error logs.
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4 Configuring the Scan Station 

Chapter 4 provides step-by-step procedures for configuring the Scan 
Station. Some of these procedures require more detailed information. 
Specific section references are made throughout this chapter as to 
where to find more detailed information in Chapter 5, Scan Station 
Administration Specifics. 

Selecting your 
default Scan Station 
settings

The Scan Station can be configured with default values for settings 
such as; Scan As, File Type, File Name Settings, etc. These defaults 
will be used when scanning documents unless they are changed by the 
user prior to scanning. If your organization typically scans black and 
white documents into PDF files, you may want to change the default 
settings to Scan As: Black and White. 

1. Double-click the Configuration Organizer icon on your desktop to 
launch the application. Because you are setting up your Scan 
Station, you should select the Administrator option under the File 
menu.

2. Select the Settings button to display the Configuration screen.

Download from Www.Somanuals.com. All Manuals Search And Download.



4-2 A-61588  July 2008 

Scan As 1. If the Scan As icon is not visible on the toolbar, click the right arrow 
until it is displayed.

NOTE: Certain selections will modify the content of other screens. For 
example, if you select Black and White, you cannot select 
JPEG output on the File Type screen. 

2. Select the type of document (Color, Grayscale, Black and White) 
that will most typically be scanned by your organization.

NOTE: If Black and White is selected, a dialog box will be 
displayed allowing you to select Best (iThresholding) or 
Normal (ATP). It is recommended that the default, Best 
(iThresholding) is selected. If Best is selected, you can 
change the values on the Black and White Adjustments 
screen. For more information, see the section entitled, 
“Black and White Adjustments“ later in this chapter.

Download from Www.Somanuals.com. All Manuals Search And Download.



A-61588  July 2008 4-3

File Type 1. If the File Type icon is not visible on the toolbar, click the right arrow 
until it is displayed. 

2. Select the file type (PDF, TIFF, JPEG) that will most typically be 
created by your organization.

• PDF - Searchable (Image + Text) — creates a single- or multi-
page document that contains both text and image data. This type 
of document uses OCR technology to read the scanned page 
and extracts text information from the image data. When you 
select this option, a screen is displayed allowing four different 
options for creating PDF files. 

- Quality, will display a screen which allows you to select a 
Good, Better or Best quality option. Selecting Good, Better, 
or Best, presets the dpi settings. As a result, the separate dpi 
settings will not have any effect when scanning in PDF mode.

- Language, this option is only available when you select PDF - 
Searchable (Image + Text). When you select Language, the 
Language screen will be displayed. This screen allows you to 
select the language you want used in the Optical Character 
Recognition employed to generate the PDF file which can be 
subsequently searched.

- Single Pages allows you to create a PDF file for every page 
scanned. If scanning a two-sided document, a file will be 
created for both the front and back page. 

- Secure allows you to enter a password that will be used to 
encrypt the file before the file can be delivered. The password 
will be sent in a separate email when Email is one of the 
destination selection. 
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• PDF - Image Only — creates a single- or multi-page document 
that contains only scanned data as a bitmap image. PDF files 
created with this option are not text searchable. When you select 
this option, a screen is displayed allowing three different options 
for creating PDF files. 

- Quality, will display a screen which allows you to select a 
Good, Better or Best quality option. When saving a file as 
PDF, predefined scanner resolution settings will be used 
when selecting Good (150 dpi), Better (200 dpi), and Best 
(300 dpi). The scanner dpi settings will not be used and will 
be ignored when scanning in PDF mode. 

- Single Pages allows you to create a PDF file for every page 
scanned. If scanning a two-sided document, a file will be 
created for both the front and back page. 

- Secure allows you to enter a password that will be used to 
encrypt the file before the file can be delivered. The password 
will be sent in a separate email when Email is one of the 
destination selection. 

• JPEG — this option is only available if your Scan As selection is 
Color or Grayscale. JPEG creates multiple files, one for each 
side of a scanned page. If you select this option, you can select a 
JPEG quality of Draft, Good, Better, Best or Superior. 

NOTE: The quality settings will greatly impact the final size of the 
file (Draft producing the smallest file size and Superior 
producing the largest file size).

• TIFF - Multi Page — creates a single file that contains all of the 
scanned pages.

• TIFF - Single Page — creates multiple files, one for each side of 
a scanned page.

NOTES: 

• Color/Grayscale TIFF documents can only be Uncompressed 
or JPEG compressed. Black and white documents can either 
be uncompressed, JPEG compressed or compressed with 
Group 4 compression.

• All faxed documents will be delivered as black and white, 
Group 4 compressed TIFF images.

• PDF files are not effected by the dpi settings used, and are 
affected only by the Good, Better, or Best options. 
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Setting Shortcuts Setting Shortcuts are a way for you to create personalized groups of 
scanner settings to make scanning easier. If there are settings that you 
use frequently, you can create a shortcut for these settings and save 
them to your configuration. The Scan Station application software 
provides six predefined Setting Shortcuts.

• Defaults
• Black and White Document
• Black and White Document (OCR Quality)
• Color Document
• Color Document (OCR Quality)
• Color Photograph 

These shortcuts are provided for your convenience and cannot be 
deleted. They can be used as a template to create other shortcuts. 

1. If the Setting Shortcuts icon is not visible on the toolbar, click the 
right arrow until it is displayed. 

Changing the Scan Station default settings
2. Click the Defaults Setting Shortcut.

3. Scroll through each of the scanner setting icons (e.g., File Naming, 
Scan As, etc.) and make any necessary changes. As you scroll 
through the other settings, the name of the selected shortcut will be 
displayed in the title bar as a reminder of which shortcut you are 
editing.

4. Select File>Save to save the new default settings to the 
configuration file.
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Creating a new Setting Shortcut
1. Select the Setting Shortcut icon.

2. Select Edit>Add Item. The Add New Setting Shortcut dialog box 
will be displayed. 

3. Enter a shortcut name in the Description field.

4. Select the shortcut that best defines the settings you want to begin 
with from the Create From drop-down list. 

5. Click OK.

NOTE: The new shortcut will appear at the top of the list. You can 
edit and save any changes to the shortcut in the same way 
as previously described.

Deleting a Setting Shortcut
1. Select the Setting Shortcut that you want to delete.

2. Select Edit>Delete Item. The message, Are you sure you want to 
delete this item will be displayed.

3. Click Yes to delete the shortcut. 

NOTE: The six predefined Setting Shortcuts cannot be deleted.

Modifying a Setting Shortcut
1. Select the Setting Shortcut you want to modify.

2. Scroll through the scanner setting icons (e.g., Scan As, File 
Naming, etc.) you want to change and make any desired changes.

3. When finished, click File>Save. 
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File Name Settings The Configuration Organizer allows you to define values that determine 
the location and file name used when creating scanned documents. 
The File Name Settings option allows you to define a Folder Name 
where all scanned documents will be placed when scanning to either a 
network folder or a USB flash drive destination. You can also define the 
File Name Prefix that will be applied to every scanned document 
created. Scanned documents are typically created with this prefix and 
have an optional date and time stamp appended to the prefix. For 
example, if you define a prefix of receipts and a folder name of 2007, 
the scanned document file name will have the format: 
receipts_20070117_092219.tif and will be placed in a folder called 
2007.

1. Define the Folder Name where all scanned documents will be 
placed when scanning to a network shared folder, FTP location or 
flash drive destination.

2. Define the File Name Prefix that will be used for creating each 
scanned document. This prefix will be used as the file name with a 
date and time stamp appended. The appropriate file name 
extension will be appended (.pdf, .jpg, .tif).

NOTE: You can define the default Folder Name where scanned 
documents will be placed if scanning to a network or USB flash 
drive destination. If you leave the Folder Name blank, the file 
will be created in the root directory of the configured destination. 
You can also define the default File Name Prefix that will be 
used to create each scanned document. If no changes are 
made, the default file name prefix will be used.
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The Advanced option provides access to two additional options: 
Interactively Name Scanned Files and Add Date/Time Stamp. 

• Interactively Name Scanned Files — selecting this option will 
require the user to enter a file name for each destination selected 
during a scan job. This option should be used with caution as it will 
require an extra step each time a document is scanned.

• Add Date/Time Stamp — by default, Date and Time Stamps are 
appended to each file name the Scan Station creates. If the user 
wants, they can turn this option off. When turning this option off, only 
the file name prefix and the appropriate file name extension will be 
used to create the file name. 

For more information, see the section entitled, “File Name settings” in 
Chapter 5, Scan Station Administration Specifics.

Input Document Is If your organization typically scans one-sided documents, select One 
Sided as the default. If Two Sided is selected, the Scan Station will 
simultaneously scan the front and back of a document in a single pass. 

• NOTES:
This setting can be changed by a walk-up user for a single scan 
session if required. The setting will be changed back to the default at 
the end of the scan session.

• The two-sided option can be used in conjunction with blank page 
detection for better performance. See the section entitled,  
“Advanced options” later in this chapter to enable blank page 
detection.
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Resolution Select a default resolution from 75 to 600 dpi. 200 dpi is the default. For 
best OCR results, if you are creating a PDF.

Document Type If your documents typically contain a mixture of both text with graphics, 
keep this option as the default. Otherwise, select the document type 
that will most frequently be scanned by your organization. 
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Black and White 
Adjustments

If you selected Black and White as your Scan As setting, the Black 
and White Adjustments screen will be enabled.

• If you selected Normal, you can select and change the Contrast and 
Threshold setting. 

• If you selected Best (default, recommended), you can only select 
and change the Contrast setting. 

• Use the up and down arrows to select the desired values and then 
click the green button next to the value. This selects the value and 
closes the dialog box.

NOTE: If your Scan As selection is Color or Grayscale, the Contrast 
and Threshold settings are disabled. 
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Copies for Printing This option is not intended to be used during the configuration setup. 
Any changes to this during configuration will be ignored. This value is 
intended to be set for each scan session by the user. The default is 1.

Advanced option The Advanced option allows you to select the Blank Image Detection 
option. This option is used to detect blank pages (i.e., the back side of a 
document), so these pages can be discarded. This is typically used 
when scanning black and white documents to either TIFF or PDF. For 
black and white documents the default is 5 KB. The default threshold 
changes depending on the Scan As setting. Document images that fall 
below the threshold will be discarded.

NOTE: The Blank Page Detection feature should not be used when 
scanning color documents, as it will not accurately detect blank 
pages in this mode.
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Saving your 
configuration 
settings

After configuring your Scan Station, save your configuration settings. 
Insert your USB flash drive into the USB port on your PC after the 
Configuration Organizer is running. This allows the Configuration 
Organizer to recognize the presence of the flash drive. If the flash drive 
is inserted before the application is launched, the flash drive option will 
not be available on the Save Configuration To dialog box. 

1. Click the Save to USB flash drive icon at the top of the screen to 
save the configuration file. 

The Save Configuration To dialog box will be displayed. By default 
the Local backup option is selected. If you choose to create a local 
backup, a copy of the settings will be saved in the same directory as 
the Configuration Organizer. 

2. Select where you want to save the configuration settings and click 
Save.

NOTES:

• If the flash drive was inserted before the application is launched, 
remove the flash drive and re-insert it.

• If Remote Configuration is enabled, check the Folder option 
and Browse to the network location where configuration files are 
stored.

• If all three options are selected, the configuration file will be 
saved to three different locations at the same time. 
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Updating your Scan 
Station settings

When you have saved your administrative configuration on your flash 
drive, you can take these settings to a Scan Station and update the 
Scan Station.

1. Insert your USB flash drive in the USB port on the Scan Station.

2. If the Scan Station configuration previously had a password 
assigned to it, you will be prompted to enter that password before 
proceeding with any changes. 

If the configuration settings on the USB flash drive are different than 
those found on the Scan Station, the following screen will be 
displayed.

3. Click Yes. The Select Settings To Replace screen will be displayed.

4. By default, all listed settings will be selected for update; therefore, 
unselect the setting(s) you do not want to update. Use the arrows to 
scroll through the list to display additional settings. 

5. Click Update. 
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NOTES:

• If there are additional settings on the Scan Station (e.g. email 
group, etc.) that are not on the flash drive configuration or if there 
are new settings on the flash drive that are not on the Scan 
Station, you will be prompted to either add or remove these 
settings. 

• If you do not want to change settings at this time, click Skip. If 
you click Skip, the Configuration mode with the Settings screen 
displayed.

When the settings are saved, the Scan Station will still be in 
Configuration mode with the Settings screen displayed.

Any changes made to any of the settings while in “local 
administrator” mode will be saved immediately to the Scan Station.   
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Managing your 
destination groups

This section provides procedures for adding, renaming, deleting, and 
reordering groups (e.g., email, network folder, printer and FTP) as well 
as procedures for managing items in each of the group types. For 
simplicity purposes, only the procedures for managing an email group 
will be displayed. The steps required to manage other group types and 
their entries are the same, unless otherwise noted. 

This section describes the creation and use of an administrative 
configuration file. The Configuration Organizer can also be used to 
create user configuration files. For more information about creating 
user configuration files, see the User’s Guide for the Kodak Scan 
Station 100, A-61544.

For more information about the specifics of the other destination types 
(e.g. networking, printing, FTP), refer to Chapter 5, Scan Station 
Administration Specifics. 

Toolbar The Toolbar provides quick access to commonly used features. The 
toolbar is always displayed and you cannot add, delete or move toolbar 
buttons. 

NOTE: For the purpose of this manual, procedures are indicated by 
using the menu options. Depending on what method is easiest 
for you, you can use the toolbar buttons or shortcut keys for any 
desired action. 

Icon Description
Saves the configuration file to the USB flash drive or 
hard drive.

Creates a new item in the selected group.

Searches for an item in the selected group.

Renames the selected item. 

Deletes the selected item.

Moves the selected item up one position in the list.

Moves the selected item down one position in the list.
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Creating groups and 
adding items

1. In the Configuration Organizer window, access Destination mode 
and select Edit>Add Group>E-Mail. An Email icon is added to the 
toolbar on the Configuration Organizer window. 

2. To add an email address to a specific email group, select the email 
group icon you want to add an address(es) to and select Edit>Add 
Item or press the Ins key. The Add dialog box will be displayed. 

3. Enter the name and address.

NOTE: If you do not want the email address placed in alphabetical 
order, uncheck Add to list alphabetically; otherwise the 
email address will be listed alphabetically.  

4. Click OK. 
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The email address will be added to the selected email group and 
the address will be listed on the Configuration Organizer window.

5. Repeat Steps 2 - 4 for each email address you want to add to a 
specific email group.

Editing items within a 
group

Existing items within a group can be edited. You can change the 
description as well as the address. 

1. Select an item within a group.

2. Select Edit>Rename Item to display the Rename dialog box. 

3. Make any desired changes in the Description or Address fields.

4. Click OK.
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Deleting items within a 
group

To delete an item within a group:

1. Select the group that you want to delete the item from.

2. Select the item from the list that you want to delete.

3. Select Edit>Delete Item.

NOTE: You will not be prompted to confirm the deletion of the item. If 
you delete an item by mistake, you can close the application 
and the following message will be displayed.

Click Yes to discard the changes. The application will close 
but your changes will not be saved.

Renaming groups By default, when you add an email group, the group is named E-mail.

1. Access Destination mode and select the email group that you want 
to rename and select Edit>Rename Group. The Rename Group 
dialog box will be displayed. 

2. Make the desired change in the Description field and click OK. The 
updated change will be displayed on the main Configuration 
Organizer window.

3. Click OK.
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Deleting groups 1. Access Destination mode and select the email group you want to 
delete. 

2. Select Edit>Delete Group. The following message will be 
displayed.

NOTE: Use caution when deleting groups as all items associated 
with the selected group will be deleted. This operation 
cannot be undone.

3. Click Yes to continue.
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Moving groups and 
items within groups

The order in which the groups are displayed in the Configuration 
Organizer is the same order they will be displayed on the Scan Station. 
If you want a specific group to be displayed as the first selection or in a 
special order, you can reorder the groups the way you want them 
displayed. 

1. Click the group you want to move. 

2. Select Layout>Move Group Left or Layout>Move Group Right 
(or click Ctrl-left arrow, Ctrl-right arrow). The group will be moved 
one position to the left or right. 
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Moving items within groups
1. Select the item within the list that you want to move.

2. Select Layout>Move Item Down or Layout>Move Item Up (or 
click Ctrl-down arrow, Ctrl-up arrow). The item will be moved up or 
down one position.

NOTE: If you want to move items/groups many times, it is 
recommended that you use the Ctrl key sequences as this will 
be faster.
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Importing an email 
address book

CSV (comma separated value) files are data files that represent 
database information. Each row contains individual data values that are 
separated by a comma. Each comma found on a line of text represents 
a column of data from the original database. The example below shows 
typical data exported from Microsoft’s Outlook Express. Note that the 
first row contains the data column header information and not actual 
data.

First Name,Last Name,E-mail Address
Smith,John,johnsmith@rochester.rr.com
Tom,Brown,Tombrown123@yahoo.com
William,Doe,wdoe@msn.com

Outlook Express allows you to export your email address book to a 
comma-separated file. When exporting your email address book a 
dialog box will be displayed that provides the selection of which data 
columns to export.

Other mail programs may or may not provide this selection capability. 
To simplify the process it is recommended that only the first name, last 
name, and email address be exported. Once the file is exported, it can 
then be imported into the Configuration Organizer.

Many email client applications will automatically export the column 
headings as the first row of data. When using the Configuration 
Organizer, the Import Email Addresses dialog box provides you with the 
ability to “skip first row” of data. Some email applications will also export 
the data with additional quote characters surrounding the data. The 
Configuration Organizer will remove these quotes prior to importing the 
data.

The following data:

“First Name”,”Last Name”,”E-mail Address”
"John","Smith","johnsmith@rochester.rr.com"
"Tom","Brown","Tombrown@yahoo.com"
"William","Doe","wdoe@msn.com"

will be changed to:

First Name,Last Name,E-mail Address
John,Smith,johnsmith@rochester.rr.com
Tom,Brown,Tombrown@yahoo.com
William,Doe,wdoe@msn.com

After browsing and selecting a CSV file, a preview will be displayed 
showing the results of the file Column Location selections. As the 
column selections are changed, the preview will reflect these changes. 

For example, if the three file Column Location values are 1, 2, and 3, 
then based on the example data shown above, the preview would 
display the following:

The first name and last name are combined to form the email address 
display name. The email address is used to create the actual email 
address.

First Name Last Name Email Address
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To further illustrate, if all three Column Location values were set to 1, 
then the preview would look like:

To import your email address book:

1. In the Configuration Organizer window, access Destination mode 
and select the email group you want to import your email address 
book to. 

2. Select Edit>Import E-mail Addresses. The Import E-mail 
Addresses dialog box will be displayed.

3. Specify the file containing the addresses. If necessary, use the 
Browse button to help locate the file.

4. If your list has a title row and you do not want to import the title row 
information, check Skip first row of data.

First name First Name First Name
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5. Specify the columns in the CSV file that contain data for First 
Name, Last Name, and Email Address.

The First Name, Last Name, and E-mail Address fields allow you to 
map these values to the columns in which they appear in the CSV 
file.

6. Click Import. The email addresses from the CSV file are added to 
the Email group that you selected on the Configuration Organizer 
window.

The Configuration Organizer will report the number of email 
addresses successfully imported.

Adding addresses 
using LDAP

If you have the LDAP server correctly configured, you can use this 
connection to search the network address book for email addresses. 
Any addresses found while searching can be added to the currently 
selected email group. To add an email address:

1. Click the Search icon on the main Configuration Organizer 
toolbar. The keyboard will be displayed.

2. Enter the last name of the person you are searching for and click 
Done. The Address Search Results list will be displayed. 

3. Select one or more of the addresses found in the list and click 
Done. The addresses will be added to the email group. 

NOTE: If more than 20 addresses are found that match the search 
criteria, you may want to refine your search by adding more 
information, such as the first name of the person you are 
searching. e.g., “smith joe” instead of just “smith”.
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Configuring FTP 
destinations

FTP destinations require a slightly different configuration than the other 
destinations. The Configuration Organizer allows you to configure both 
FTP and proxy server settings. Depending on your network 
configuration you may or may not have to communicate with FTP sites 
through a proxy server. For each FTP destination you can specify 
individual username and password settings. This is important as you 
may be communicating with FTP sites located at different companies or 
on different company servers.

1. Select Edit>Add Group>FTP. The Add: Ftp Folder dialog box will 
be displayed.

2. Make an entry in the Description, Folder, Username and Password 
fields. The Folder field should contain a complete path to the FTP 
site including the subfolder into which scanned documents will be 
placed. For example, //ftp.acme.com/documents would connect to 
the FTP site ftp.acme.com and place the scanned documents in the 
folder documents.

NOTE: Any additional folders defined in the File Naming Settings 
screen will also be used when creating the scanned 
documents. See the section entitled, “File Name Settings” 
earlier in this chapter. 

3. If the FTP site communicates on a port other than Port 21, change 
the value using the up and down arrows. 

4. You may optionally select Passive if required by the FTP server. 
Passive is most commonly used if the FTP site is outside the 
firewall.

5. If you do not want the address added to the list alphabetically, click 
Add to list alphabetically to uncheck it. This will add the item to 
the list in chronological order.

6. If your company requires the use of proxy servers, click the Proxy 
button and go to the next section; otherwise click OK.
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Specifying Proxy settings If your company requires the use of a proxy server before 
communicating with an FTP site, you must define these proxy settings 
by clicking on the Proxy button. The Proxy Settings dialog box will be 
displayed.

1. Select the Proxy Type. USER after login and None are the only 
two supported options at this time. 

2. If USER after login is selected, the rest of the fields are available. 
Enter the Proxy Address in the form of a Fully Qualified Domain 
Name (e.g., FTP.acme.com) or as an IP address.

3. Enter the Username and Password required to access the proxy 
server.

4. If the proxy server is configured to communicate on a port other 
than Port 21, change or enter the value using the up and down 
arrows or keyboard.

5. Click OK.
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Configuring printers The Scan Station uses the Microsoft “Point and Print” technology for 
installing print drivers and connecting to network printers. Typically, 
network printers are attached to print servers which manage the 
scheduling of print jobs for one or more network printers. These print 
servers manage print queues for each connected printer and can also 
deliver and install print drivers to other network PCs or devices. 

The Scan Station can connect to printers in the following ways:

• Connect to a printer that is connected to a print server on a network 
domain.

• Connect to a printer that is shared by another computer on a network 
workgroup.

• Connect to a network printer that is directly connected to the network 
via an Ethernet cable plugged directly into a router or hub.

In each of these scenarios, Microsoft Windows may also require login 
credentials for any device requesting access to a network printer. Each 
of the scenarios listed above is described in more detail below.

Connecting to a printer that 
is connected to a print 
server on a network 
domain

1. Enter any text that describes the printer in the Description field. 

2. Enter the fully qualified path to the print server and print queue (e.g., 
\\printservername\printqueue or \\192.168.1.101\printqueue).

NOTE: The use of IP addresses when accessing a print server is 
guaranteed to resolve the path to the printer. Fully qualified 
domain names may not resolve in certain network 
environments.

3. If the network domain is configured to require authentication to 
install a printer driver, enter the Username, Password, and 
Network Domain names.

4. When finished, click OK.

NOTE: If proper authentication is not provided, the printer and its driver 
may not be installed on the Scan Station.
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Connecting to a printer 
shared by another 
computer on the network 
workgroup

1. Enter any text that describes the printer in the Description field. 

2. Enter the fully qualified path to the Shared computer and the share 
name assigned to the printer (e.g., \\mypc\sharedprinter or 
\\192.168.1.101\sharedprinter).

NOTE: The use of IP addresses when accessing a print server is 
guaranteed to resolve the path to the printer. Fully qualified 
domain names may not resolve in certain network 
environments.

3. If the PC requires authentication credentials to access the shared 
printer, enter the Username and Password. Leave the Domain 
Name blank.

4. When finished, click OK.
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Connecting to a network 
printer that is directly 
connected to the network

This option is more complicated than the other two in that it requires the 
printer to be shared by a PC on the network at least temporarily, while 
the printer drivers are downloaded and installed on the Scan Station. 

Before setting up a printer that is directly connected to the network, the 
printer must first be “shared” from a computer on the network. The 
shared printer must also be configured to provide a Windows XP driver 
for the printer. Once shared, there are two pieces of information you 
must gather from this computer: the driver name and the port name. 

On the PC that is sharing the printer: 

1. Click Start>Settings>Printers and Faxes and select the installed 
Printer. The control panel for this printer will be displayed.

2. Write down the Driver Name as it appears on the Control Panel. 
The location of this information may be different for each printer.
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3. On the Ports tab of the Control Panel, write down the exact text that 
appears on the selected Port value. 

NOTE: As shown below, this would be “IP_192.168.2.137”.

4. Return to the Configuration Organizer and select or create a printer 
group and select Edit>Add Item. 

5. Enter any text that describes the printer in the Description field. 

6. Enter the IP address of the network printer (e.g., \\192.168.2.137).

7. Enter the Username and Password and optional Network Domain 
that will be used as credentials on the PC that is temporarily sharing 
the network printer.
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8. Click the Advanced button to display the Advanced dialog box. 

9. Enter the fully qualified address to the PC that is sharing the printer 
(see Step 1) including the share name (e.g. 
\\workgrouppc\BrotherH).

10.With the information gathered in Steps 1 and 2, enter the driver 
name and the port name in their respective fields.

11. Click OK on both the Advanced and Add: Printer dialog boxes.

The printer driver will be installed from the sharing PC. A connection 
will be made between the printer and the Scan Station using the IP 
address entered on the Add: Printer dialog box. After the initial 
installation, the shared printer connection is no longer required and 
the Scan Station will be able to communicate directly with the 
network printer.

12.Click Advanced to display the Advanced dialog box.

The Advanced dialog box allows you to enter the information 
required to access the printer driver on the shared PC. This 
information will be used to install the printer driver on the Scan 
Station. 

13.Enter the fully qualified address to the shared PC and the printer 
share name. 
(e.g. \\workgroupPC\BrotherH, \\192.168.2.137\BrotherH)
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5 Scan Station Administration Specifics

This chapter provides detailed administrative information about your 
Scan Station including:

• in-depth information regarding Scan As settings, File naming settings 
and E-mail group settings.

• securing your Scan Station and the various password options 
available.

• loading and saving configuration files.

• updating your Scan Station.

• network configuration details.

Scan As settings When selecting a Scan As setting, note that each selection has an 
impact on the settings that are available on other screens in the 
Settings mode. The following table describes how each Scan As 
selection will impact other selections.

Scan As setting File Type setting Black and White Adjustments
Color PDF (Searchable/Image only)

PDF (Multi/Single page)
TIFF (Multi/Single page) 
JPEG (Single page)

Not available

Grayscale PDF (Multi/Single page)
JPEG (Single page)

Not available

Black and White

PDF (Searchable/Image only) Not available
TIFF (Multi/Single page)

Best (iThresholding)
Normal (ATP)

Contrast available
Contrast and Threshold 
available
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File Naming settings The Scan Station offers several ways you can customize how scanned 
documents are delivered to their final destinations. While in Settings 
mode you can select the File Name Settings icon which provides three 
options for naming and delivering your scanned documents:
• Folder Name
• File Name Prefix
• Advanced: provides two additional settings that allow you to 

optionally add a date and time stamp to the resulting scanned file 
name, and allows the user to interactively name files as they are 
delivered to each destination.

Folder Name — allows you to define the final folder(s) where scanned 
documents are deposited. This option only pertains to documents that 
are being scanned to either a Network destination (FTP or shared 
folder) or a USB flash drive. If a folder name is defined, it will be 
appended to the full path selected in the destination. For example, if a 
network folder defined as: \\myserver\myfolder\docs is selected and the 
Folder Name is set to “designdocs” then the scanned document is 
placed in the following folder: \\myserver\myfolder\docs\designdocs.

If multiple folder levels are defined in the Folder Name field, the 
scanned documents will be placed in the full path defined by the 
destination and the “Folder Name”. In the previous example, if the 
“Folder Name” was defined as “designdocs\worddocs” then the 
scanned document is placed in 
\\myserver\myfolder\docs\designdocs\worddocs.

In either case, if the path to the final destination does not exist, then the 
Scan Station attempts to create the full path to the destination. This is 
true for network destinations as well as USB flash drive destinations. As 
in the previous example, if the sub-folders docs and/or worddocs did 
not exist, they would be created prior to copying the scanned document 
providing the Scan Station account has appropriate user rights.

File Name Prefix — allows the user to define the file name used when 
copying the scanned document to it’s destination. If this field is left 
blank, the default file name KSS100 will be used. However, if a special 
file name needs to be defined, then the user can enter the file name of 
their choice. For example, if the following entry is made for File Name 
Prefix: “Receipt” then all files created would take on the form of 
“Receipt_20070120_100155.xxx” where the .xxx represents the 
appropriate file name extension (either .jpg, .tif or .pdf) and 
“20070120_100155” represents the date and time the file was created.
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Advanced — provides two additional settings that allow you to 
optionally add a date and time stamp to the resulting scanned file 
name, and allows the user to interactively name files as they are 
delivered to each destination. The Add Date and Time Stamp option is 
the default. This is the default so when documents are scanned and 
delivered to the selected destination, they will always have a unique 
name. This also avoids inadvertently overwriting existing files. The 
Interactively Name Files option allows the user to name the scanned 
document just before it is delivered to each destination. Before copying 
the document to the selected destination, the Scan Station displays the 
virtual keyboard on the display and allows the user to enter a new file 
name. 

NOTE: Be careful when enabling the Interactively Name Files option, 
as it requires user interaction for each selected destination. For 
example, if the user selects five different destinations, they will 
be prompted five times to enter a file name.

E-mail groups Chapter 4 provided procedures for creating, modifying and deleting 
groups of destinations and the items within destination groups. 
Examples were provided that were pertinent to all groups of 
destinations. This section discusses a special case for creating email 
groups. Ordinarily, email groups contain a list of entries that consist of 
one e-mail address per entry. However, you can create a list within a 
single entry within the email group. The following illustration describes 
both the typical case of one email address per item, followed by an 
example that has multiple addresses per entry.

Example 1
The Description field contains a mail recipient’s name, and the Address 
field contains a single email address.

Description: John Doe
Address: john.doe@acme.com

Example 2
The Description field contains a group name, and the Address field 
contains multiple email addresses separated by commas.

Description: John Doe Family Group
Address: john.doe@acme.com, jane.doe@hypernet.net, 
juniordoe@statecollege.edu

By separating a list of email addresses with a comma, a group of email 
addresses is created. As this entry is created, each email address in 
the Address field is validated to ensure the proper format. If an 
improper email address is entered, the following message will be 
displayed:
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Securing your Scan 
Station

Network security is an important part of every day business and it is 
important that network devices do not allow intrusions from outside 
sources. The Scan Station 100 is configured to prevent external attacks 
from the Internet, and from direct access by users. With this in mind, 
several steps were taken to block access to the Scan Station’s 
operating system. 

• First, the Scan Station has an internal firewall active that only allows 
a response to an “echo (ping)” command. Inbound ports are blocked 
and will not respond to queries from the network. 

• Second, the Scan Station is protected from external intrusions via the 
USB ports found on the front and back of the device. The operating 
system is configured to disable any auto-run action that could occur 
when presenting a new USB device to the system. The Scan Station 
application recognizes the presence of a USB removable device, but 
will only open and read files that have been created and encrypted 
specifically for use by the Scan Station. Any file found on a 
removable device that is not properly encrypted will be ignored. This 
makes it almost impossible to introduce a virus from inserting a 
removable device with an infected executable. 

• Finally, viruses frequently find their way into a network-connected 
computer via email. Most viruses are spread as email attachments 
and infect a computer after the email has been opened and the 
attachment executed. The Scan Station does not receive any 
incoming emails, therefore, it cannot be infected in this manner.

Password protecting your 
configuration file

There are several ways an administrator can secure the Scan Station 
using passwords. As previously described in Chapter 3, the 
administrator can add a password (32-character alphanumeric PIN) to 
any administrative configuration file created (select 
User>Configuration Password and enter a password). This prevents 
access to the configuration file in the following ways:

• If the configuration file is saved with this password, it cannot be read 
by a user running the Configuration Organizer without knowing the 
password. Upon insertion of a flash drive that contains a password-
protected configuration file, the user will be prompted to enter the 
password. Failure to correctly enter the password forces the 
Configuration Organizer to ignore the file and proceed as if no file 
exists. 

• When a password configuration file is used to update a Scan Station, 
the password is applied to the configuration on the Scan Station and 
any attempts to modify the Scan Station’s configuration requires the 
entry of the correct password before any changes can be made. 
Because of this protection it is imperative that the password be kept 
in a safe place and not forgotten. If the password is forgotten, it will 
require you to contact Kodak Service to unlock the Scan Station.
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Password protecting your 
Scan Station (user access)

Another password protection feature is assigning a 32-character 
alphanumeric password directly to the Scan Station. This requires any 
user wanting to use the Scan Station to know the password prior to use. 
This is intended for use in companies or departments that have 
sensitive material that they want to prevent being scanned and 
distributed. The device password setting is found on the Configuration 
Organizer while in “Settings” mode. By clicking on the Device icon and 
selecting Device Password, you can enter a password that blocks 
access to all users who do not know the password. On a Scan Station 
that is password-protected, users will be given three tries to correctly 
enter the password. After the third failed attempt, the Scan Station will 
display a warning message for several minutes and return to the 
password entry screen.

The Device password also works in conjunction with the inactivity timer 
built into the Scan Station. In normal operation, after a Scan Station has 
been used and has remained idle for one minute, a warning screen will 
be displayed asking the user if they want to reset all Scan Station 
settings to the default state. If no selections are made, then after two 
more minutes of inactivity, the device will be returned to its default state. 
If the user selects OK when the initial warning is displayed, the Scan 
Station will be returned to its default state immediately. If Cancel is 
selected, the current configuration settings are maintained, the timer is 
reset and the Scan Station will start monitoring for inactivity again.

In addition to assigning a 32-character alphanumeric password, you 
can require the user to login before starting a scan session. See 
Chapter 3, “Configuration options” for more information. 

Loading and saving 
configurations

The Configuration Organizer is designed to monitor the Windows 
operating system for removable device events, which signal the 
insertion and removal of USB devices (e.g., the USB Flash Memory 
device supplied with each Scan Station). Because of this, the 
Configuration Organizer cannot detect a flash drive unless the 
application is running. Follow the recommendations below when 
creating and modifying configuration files:

1. Always start the Configuration Organizer before inserting a USB 
flash drive. If the flash drive is inserted before starting the 
Configuration Organizer, remove the flash drive and reinsert it.

2. If you insert a USB flash drive that has a configuration file on it, prior 
to making any edits, the configuration file will be recognized and 
loaded into the Configuration Organizer. 

3. When saving your configuration, you will have an option of saving 
the configuration file to a flash drive AND to a local backup. Using 
the Save to local backup option only creates a backup of the last 
edited configuration file. 

4. The configuration file is always named KSS100.xml. If you want to 
save different versions of this file, it is recommended that you create 
multiple folders which are named appropriately. 
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5. If you start by editing a new configuration file and insert a flash drive 
after edits have been made, any configuration file on the flash drive 
will be ignored and not loaded.

6. When saving to any location, if a configuration file is present, you 
will be asked if it is OK to overwrite the file.

7. If you started the Configuration Organizer, made changes and 
select File>Open, you will be notified that Changes have not been 
saved and will be lost. Are you sure you want to continue? 
Selecting No will stop the Configuration Open process.

Updating your Scan 
Station

Chapter 4 provides information and procedures for setting up and 
configuring your Scan Station. This section provides more detailed 
procedures for updating your Scan Station.

An administrative configuration file can be created using the 
Configuration Organizer and saved to a USB flash drive. There are 
three methods of updating the Scan Station. 

1. Method 1. The administrative configuration file is stored on a flash 
drive, inserted into a Scan Station, which is then updated. This 
method is manual and must be repeated for each Scan Station on 
the network. This method was previously described in Chapter 3. 
See the section entitled, “Updating your Scan Station settings” for 
procedures.

2. Method 2. The administrative configuration file is stored on a flash 
drive, with an update package. This causes the Scan Station 
configuration to be updated and installed with new software to the 
Scan Station. See the information later in this section for more 
information.

3. Method 3. The administrative configuration file and optional update 
package is stored on a network drive and the Scan Station is 
configured to poll this drive (shared folder) for updates. The Scan 
Station will automatically recognize the new configuration data or 
update package and execute an update automatically. See the 
information later in this section for more information.
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Method 2 — requires an update package and an administrative 
configuration file to be copied to a USB flash drive. When the flash drive 
is inserted into the Scan Station, the internal software recognizes the 
administrative configuration file and the update package. Once 
recognized, if the update package is a different version than the 
currently installed version, the user is prompted to update the Scan 
Station software. Both the old version number and the version number 
of the update package will be displayed. If the administrator decides to 
update the software, all the data found in the update package will be 
copied to the Scan Station and installed. When the installation is 
complete, click OK or remove the flash drive and the Scan Station will 
automatically be restarted.

If the Scan Station does not restart, press the green “soft” button on the 
back of the Scan Station. The Scan Station will shutdown in a normal 
manner. This is very important because the final installation of files 
occurs when the Scan Station is being shut down. Without the 
shutdown and restart, the Scan Station may not be properly updated 
and configured. 

NOTES:
• It is important to make the distinction between the green “soft” button 

found on the back of the Scan Station and the main power switch. 
The main power switch should only be used after the Scan Station 
has been shutdown via the green “soft” button. Using the main power 
switch will cause an abrupt shutdown of the Scan Station and may 
occasionally corrupt data files on the Scan Station. This is not 
recommended.

• You can obtain Update packages from the Kodak website or from 
your Kodak service representative. Update packages will always be a 
file called KSS100UPDATE.EXE.
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Method 3 — the Scan Station software can be configured to monitor a 
network folder where configuration files and software updates are 
installed. To set this up:

1. From the Configuration Organizer Settings mode, select the 
Advanced icon and click Remote Configuration Settings. 

From this screen, you can select and define the following values:

• Path to the folder where updates can be found.

• Which day of the week (Daily, or Every Monday, Tuesday, 
Wednesday, Thursday, Friday, Saturday, and Sunday).

• The time of day to check for updates (a 24-hour clock).

For example, you may want to monitor the folder 
\\myserver\updates\myscanstationID on Every Monday, at 7:00 a.m. 

There are two ways to remotely configure and update your Scan 
Station:

• Single file/folder update — the administrator creates a single folder 
on the network from which all Scan Stations are configured to 
monitor for updated configuration files. This allows the administrator 
to push a single configuration to all of the Scan Stations on a network 
at one time. This is the recommended method when all of your Scan 
Stations share the same configuration. 

• Multiple file/folder update — if each of your Scan Stations require a 
different configuration, it is recommended that a common folder is 
created on the network with subfolders underneath to store individual 
configuration files for each of the Scan Stations on your network. 
Each Scan Station should then be configured to monitor the 
appropriate folder for updates. 
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On the defined day of the week and time, the Scan Station checks for 
the specified folder on the network, and if found, examines the contents 
of the folder looking for a KSS100.XML file and an optional 
KSS100UPDATE.EXE file. If the KSS100.XML file is found, the 
modification date and time will be compared to the last time a 
configuration was executed on the Scan Station. If the KSS100.XML 
file is more current, the configuration settings in the file are applied to 
the Scan Station. Be sure to carefully select a time of day when the 
Scan Station will be idle for automatic updates.
When new configuration files are found, the following sequence of 
events will occur. 

1. If a new update file is found, the contents of the update will be 
applied to the Scan Station.

2. If newer settings are found, the settings will be applied to the Scan 
Station as the new default settings.

3. If required, the Scan Station will be restarted. A restart will always 
occur when an update file is found. The Scan Station will be 
restarted if the network settings for the Scan Station are modified. 

NOTE: Any changes to the device name will be ignored when 
using the remote configuration.

If the Scan Station software and the KSS100UPDATE software are at 
the same revision level, no action will be taken.

NOTE: You can “roll-back” to an older version or update to a newer 
version of the Scan Station software. If an older version of the 
KSS100UDPATE file is placed in the remote configuration 
folder, the Scan Station will be rolled back to use the older 
version of the software. If a newer version is found, the Scan 
Station will be updated with this newer software. These 
methods are also available using the manual update procedure 
(Method 1). If a Scan Station is updated back to version 1.5, 
(the first commercial release), the remote configuration facility 
will no longer be available, as this option was not yet 
implemented in version 1.5.

Network configura-
tion details

When installing and configuring your Scan Station, there are some 
things you can do, as an administrator, to prepare for an easier 
installation. Chapter 2 provides a checklist of information you need to 
connect the Scan Station to your network. This section details what 
additional steps you can take to set up your network environment for an 
easier Scan Station integration. Because the Scan Station is a network 
device, a basic knowledge of networking principals and terminology will 
be helpful. You should be familiar with the concept of creating user 
accounts (on domains), sharing folders, setting access privileges, the 
Universal Naming Convention (UNC), using IP addresses, fully 
qualified domain names (FQDNs) and creating user groups. The rest of 
this section contains a list of Best Practices to be used when 
administering Scan Stations.
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NOTE: Some of the concepts covered in this chapter assume 
knowledge of Microsoft NT Domains and permissions. Refer to 
your documentation for Microsoft Windows Server 2000 or 
Windows Server 2003 for more information.

Scan Station user groups — for network domain environments, the 
administrator should create a user group for all Scan Stations. This 
group will be used to hold account names that are assigned to each 
Scan Station. Minimally, there should be one account name that is 
assigned to each Scan Station. Optimally, each Scan Station should be 
assigned its own unique username and password and these accounts 
should be contained within a group that is reserved specifically for Scan 
Stations. These account names will be used when configuring the Scan 
Station’s network settings and entered into the Username, Password, 
and Network Domain fields.

NOTE: The Scan Station groups and login names must be given 
appropriate privileges to access the network resources that the 
user will see as Destination choices at the Scan Station.

Workgroup environments — for network environments that use the 
Microsoft “Workgroup” configuration, you may minimally be required to 
create an account name and password to be assigned to Scan 
Stations. These account names will be used when configuring the Scan 
Station’s Network settings and entered into the Username, Password 
fields. The Network Domain field should be left blank in Workgroup 
environments.

Network folders — it is recommended that you create network folders, 
for either Destination or Remote Configuration, that can be accessed 
(minimally read, write, change access) by any Scan Station login 
account or by the user group created for Scan Stations.

UNC names for folders — as an administrator, you will need to know 
the fully qualified UNC name for each network folder that will be used 
by your Scan Station(s). When configuring network destinations, this 
will be the information entered into the Address field of the Destination 
Entry dialog box. For example, you could create a folder called 
“scanfolder” on a server called “acmeserver” that would be reserved for 
Scan Station access. You would reference it by the following UNC 
name: \\acmeserver\scanfolder.

NETBIOS usage — in network environments that use routers it is 
common practice to block NETBIOS traffic on your router. You may 
need to know the IP address of the server to which you want to scan 
documents. By substituting the IP address of the server instead of the 
NETBIOS computer name, you can bypass the network traffic 
restrictions that may cause network scanning to fail. For example, the 
previously defined network address: \\AcmeServer\scanfolder should 
be replaced with something similar to: \\192.168.2.10\scanfolder.
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6 Maintenance

This chapter provides cleaning and replacement procedures for the 
Kodak Scan Station 100.

Cleaning procedures Your Scan Station needs to be cleaned periodically. If your documents 
do not feed easily, if several documents feed at the same time or if 
streaks appear on your images, it is time to clean your Scan Station. 
The section entitled, “Supplies and consumables” at the end of this 
chapter provides a listing of the supplies required to clean your Scan 
Station.

IMPORTANT: Use only non-flammable cleaners such as those provided 
through Kodak Parts Services. Do not use household 
cleaners.
Do not use cleaners in confined areas, use with adequate 
ventilation.
Do not use cleaners on hot surfaces. Allow surfaces to 
cool to ambient temperature before use.

Opening the cover 1. Open the cover by pressing the release lever.

2. When finished with the cleaning procedures, close the Scan Station 
cover. 
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Cleaning the rollers 1. With a roller cleaning pad, wipe the feed roller from side to side. 
Rotate the feed rollers to clean the entire surface.

IMPORTANT: The roller cleaning pad contains sodium lauryl ether 
sulfate which can cause eye irritation. Refer to the MSDS 
for more information.

2. Dry the rollers with a lint-free cloth.

Cleaning the feed module 1. Squeeze the plastic clamps that hold the feed module in place and 
lift the feed module out of position.

2. Wipe the feed module from top to bottom with a roller cleaning pad.

3. Reinsert the feed module into position, by aligning it into the slots 
and pushing it in until it snaps into place.
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Cleaning the imaging 
guides

1. Remove dust and debris from this area by using a Staticide wipe or 
a small brush. Be careful not to scratch the imaging guides when 
cleaning.

IMPORTANT: Staticide wipes contain isopropanol which can cause eye 
irritation and dry skin. Wash your hands with soap and 
water after performing maintenance procedures. Refer to 
the MSDS for more information 

2. Wipe the upper and lower imaging guides with an almost dry 
Staticide wipe to remove any streaks.
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Replacement 
procedures

The feed module and USB connector are the only parts that are 
customer-replacement.

Replacing the feed module Degradation of feeder performance, multiple feeds, stoppages, etc. 
indicate a need to change the feed module. Certain paper types such 
as carbonless paper or newsprint, or failure to clean regularly, and/or 
use of non-recommended cleaning solvents can shorten the feed 
module life. 

For additional feed modules, see the section “Supplies and 
consumables” at the end of the chapter. 

1. Open the Scan Station cover by pressing the release lever.

2. Squeeze the plastic clamps that hold the feed module in place and 
lift the feed module out of position.

3. Insert the new feed module into position, aligning the new module 
into the slots, and pushing it in until it snaps into place.

4. Close the cover.
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Replacing the USB 
connector 

The USB connector may need periodic replacement due to extended 
use which may be detectable due to repeated flash drive errors. Before 
changing the USB connector, be sure the USB flash drive itself is not 
defective.

Tools needed: Small Phillips Head Screwdriver. 

1. Turn off the power to the Scan Station.

2. Unplug the power cord from the wall receptacle.

3. Unscrew and remove the two screws on the back of the turret using 
a Phillips Head screwdriver. 

4. Lift the turret top cover and hold it in place (or rest it on the Scan 
Station) until you remove the ribbon cable connector.

Ribbon cable
connector
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5. Open the clamps on the ribbon cable and disconnect the ribbon 
cable from the button control panel.

6. Rotate the turret about 45 degrees.

7. Loosen the two screws (about 3 turns) on the attachment plate.

8. Remove the turret side cover.
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9. Unplug the USB cable.

10.Remove the screws from the USB connector and remove it.

11. Attach the new USB cable to the connector and tighten the screws.

12.Connect the USB cable.

13.Slide the turret side cover back into place. Be sure the attachment 
plate is seated properly. Press and hold the turret side cover in 
place and tighten the screws to secure the front and side covers.

14.Reconnect the ribbon cable by pressing it all the way into the 
connector until it snaps and clamps into place.
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15.Feed the ribbon cable back into the turret housing. 

16.Reattach the turret top cover holding the cover securely down while 
you are replacing the screws.

17.Plug in the power cord and turn the Scan Station back on. 

Supplies and 
consumables

Contact your Scan Station supplier to order supplies. 

NOTE: Items and catalog numbers are subject to change.

Description CAT No.
Kodak Feed Module 174 7849
Kodak Digital Science Roller Cleaning Pads 853 5981
Kodak Scan Station Portable USB Drive (5-Pack) 125 1842
USB Replacement Connector 844 5306
Staticide Wipes for Kodak Scanners 896 5519

Kodak Scan Station Fax Modem 128 0528
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7 Troubleshooting

Occasionally you may encounter a situation with your Scan Station 
where it may not function properly. Refer to the information in this 
chapter to help you resolve the situation before calling Technical 
Support. 

This chapter provides:

• A description of the indicator lights and error codes

• Clearing a document jam

• A problem solving chart

• Scan Station error messages

Indicator lights and 
error codes

The LED indicator light and number in the Display window on the Scan 
Station provide information on the current state of the Scan Station. In 
Normal operation, “1” will be displayed in the Display window with either 
a steady or flashing green LED. 

Flashing green — Normal operation: indicates the Scan Station is 
initializing from powering on or warming up from a power saving mode 
and preparing to scan.

Steady green — Normal operation: indicates the Scan Station is 
ready to scan.

Flashing or steady red: indicates a Scan Station error, such as the 
Scan Station cover is open. A momentary red flash during the scan 
process is an indication that data is being sent from the Scan Station.

Display window — the Display window on the Scan Station provides 
information on the status of the Scan Station.

If “0” is displayed, this can indicate that the Scan Station is plugged in 
and the main power switch is turned on, but the main computer within 
the Scan Station is off. This occurs when the green “soft” button has 
been pressed. In this state, the Scan Station is in shutdown mode and 
you need to press the green button to power up the Scan Station. When 
the Scan Station is ready, “1” will be displayed in the Display window 
and the green LED will flash while the Scan Station is warming up. 
When the Scan Station is ready, the green LED will be steady.
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Following is a listing of error codes that may be displayed in the Display 
window. When an error is indicated, the LED indicator light will blink red 
the same number of times as the number displayed in the Display 
window, alternating along with the letter “E”. Therefore, if the Scan 
Station cover is open, the number “6” and an “E” will alternate in the 
Display window and the indicator will flash red and blink six times.

1 - 5, 7 and 8 Call Service.
6 The cover is open.
9 There is a document jam.

If no action is taken, the flashing sequence will eventually stop and the 
Display window will display the error number with a steady red LED. To 
clear this, correct the error (e.g., clear a document jam) or power down 
the Scan Station completely, and turn the Scan Station back on. If the 
situation persists, contact Kodak Service.

Clearing a document 
jam

If your Scan Station stops scanning due to a document jam, follow the 
procedures below:

1. Open the Scan Station cover.

2. Remove any jammed documents from inside the Scan Station.

3. Close the cover.

Download from Www.Somanuals.com. All Manuals Search And Download.



A-61588  July 2008 7-3

Saving error log files You may be asked by Kodak Service personnel to send the log files as 
an email attachment for further diagnostics. If you are asked to provide 
these log files, proceed as follows:

1. Create an administrative configuration file on a new USB flash drive.

2. Insert the flash drive into the Scan Station’s USB port to put the 
Scan Station into local administrative mode. The Scan Station will 
display the Settings mode icons.

3. Using the arrows, scroll until the Diagnostics icon  is displayed 
and selected.

4. Click Save Logs and click Yes to save the log file to the flash drive.

NOTE: The following files will be saved to the flash drive: analog.log 
and kss100.xml.log.
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Problem solving Use the chart below as a guide to check possible solutions to problems 
you may encounter when using the Kodak Scan Station 100.

Scan Station Issues Possible Solution
Regular cleaning and Scan Station maintenance is required to keep documents scanning smoothly and provide 
optimum image quality. Follow the recommended cleaning procedures in Chapter 6, Maintenance for best Scan 
Station performance. 
Documents are jamming or multiple 
documents are feeding

Make sure that:
• the input tray and side guides are adjusted for the width of the 

documents you are scanning.
• the input tray does not have more than 50 sheets of 75 g/m2 (20 lb.) 

paper in the tray
• the output tray is adjusted for the length of the documents you are 

scanning.
• all documents meet the specifications for size, weight and type as 

outlined in the section entitled, “Document preparation” in the User’s 
Guide.

• the feed module is worn and needs to be replaced.
• the Scan Station is clean.
• the feed module is clean, installed properly and securely in place.

Image quality is poor or has decreased • Clean the Scan Station. See the procedures in Chapter 6, 
Maintenance. 

Distorted images The feeder holds up to 50 documents in the input tray. While scanning is 
taking place, you cannot add documents to the feeder. If you do add 
documents, your images may be distorted.

No images are being displayed If you are scanning one side of a document, be sure the side you want to 
scan is placed toward the feed tray (not facing you). For more 
information, see the User’s Guide.

Image has clipped corners If your images have clipped corners, the skew angle was too large for the 
Scan Station to handle. Be sure documents are placed in the input tray 
with the edges aligned and the side guides positioned correctly to 
accommodate the size documents you are feeding to avoid large skew 
angles.

First image in a batch appears “washed 
out”

If the scanned documents in a batch have more than a 25-degree skew, 
the first image in the batch may appear washed out. Be sure that 
documents are placed in the input tray with the edges aligned and the 
side guides positioned correctly to accommodate the size documents 
you are feeding to avoid large skew angles.

Download from Www.Somanuals.com. All Manuals Search And Download.



A-61588  July 2008 7-5

Scan Station Issues Possible Solution
Image appears to be cut off If you are scanning a document with a reflective area (such as a 

hologram on a credit card), and this reflective area is fed “face up” and 
off-center such that it passes over the left-edge sensor, the sensor will be 
triggered as if it were the end of the page and will result in a cut-off 
image. 
• Rescan the document by feeding it face down.

Roller marks appear on the document 
after scanning

Clean the rollers. See the procedures in Chapter 6, Maintenance. 

Images have black background bleed- 
through

When scanning translucent documents, black bleed-through may be 
displayed on the image. To minimize this, adjust the Contrast value or 
select Fixed Processing to improve the image. 

Dark vertical line on edge of document This indicates that dust may be on the calibration strip. Clean the upper 
and lower imaging guides, including the white strip. See Chapter 6, 
Maintenance for procedures. 
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Network Authentication Issues Possible Solution
Domain authentication Check the following to verify for correct connections in a network 

domain. These settings can be found in Settings mode on the 
Configuration Organizer, by clicking the Device icon.
• Device name
• Network username and password
• Domain name
If any of these is not set correctly, the Scan Station will not be able to 
access the domain.

Ensuring Device name uniqueness All Scan Stations have a default name assigned from the factory. The 
default name is: kssxxxx-xxxx. Where x = the serial number on the back 
of the Scan Station. This ensures that all Scan Station device names are 
unique. The default name of this field in the Configuration Organizer is 
“Scan Station”. If you leave this option blank when you are configuring 
the Device Name (clicking the Device icon and selecting Device Name), 
the Scan Station will continue to use the default factory-installed device 
name. If you want to change the default Device name, you must select a 
unique name. 

Checking the account name and 
password

If your Scan Station does not scan to a network location or stops 
scanning to a network location, you may have issues with the logon 
credentials supplied to the Scan Station. When creating accounts that 
are assigned to the Scan Station, certain properties may be applied to 
the account such as, Change password upon first log on and Change 
password every xx days. It is recommended that these types of 
restrictions are not applied to accounts that will be used for a Scan 
Station. 

A network administrator can verify the account settings assigned to a 
Scan Station by using the credentials to log on to a normal network 
computer. If you are unable to logon to your network using these 
credentials, you probably have a problem with the account. A network 
administrator can modify the settings applied to the account to resolve 
these issues. It may also be necessary to reset the password.

Workgroup authentication If having trouble writing to a locally shared folder in a workgroup, check 
the permissions attached to the folder from the PC on the network that is 
sharing the folder. Make sure the folder’s Permissions allow access to 
the Scan Station.

Email Authentication Verify that the authentication method defined in the Scan Station settings 
match the authentication method of your SMTP server. Currently the 
Scan Station supports simple password, NTLM and Challenge 
Response. These settings can be verified by using a Windows mail client 
such as Outlook Express and creating a mail account that uses the 
username and password assigned to the Scan Station.

SMTP server problems Follow these procedures to resolve issues with the SMTP server 
address:
• Verify that other email clients on different machines are able to send 

mail and reach the SMTP server.
• Change your configuration file to identify the SMTP server with an IP 

address instead of a Fully Qualified Domain Name. If you are able to 
reach the SMTP server with the IP address but not the FQDN, you 
have a DNS resolution problem. Check to make sure you are able to 
reach the DNS server and that it correctly resolves FQDNs.
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Network Authentication Issues Possible Solution
Your network Domain name To find the domain name your Scan Station will use, follow these steps:

1. From a PC logged onto the same network/domain that the Scan 
Station will use, right click on My Computer and select Properties.

2. From the Properties window select the Computer Name tab.

If you are on a domain, the Domain name is listed in the Domain field 
(see above). 

3. Copy the Domain name so you can enter into the Domain field of the 
Default Credentials in the Configuration Organizer.

4. Go to the Configuration Organizer and click the Device icon and 
select Default Credentials, then select Domain. 

5. Enter the Domain name on the virtual keyboard and click OK.
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Network Authentication Issues Possible Solution
Finding the SMTP server address Use the following procedures to find the SMTP server address:

• Examine the settings of the mail client in use on your workstation to 
find the IP address or Fully Qualified Domain Name for the SMTP 
server, or

• examine email sent from an internal mail client and display the full 
email header, or

• ask the administrator of the mail server for this information.
Verifying an SMTP server address Send mail to the SMTP server using a mail client application from a PC 

attached to the same network as the Scan Station. 
• If the mail was successfully sent and received, the SMTP server 

address is valid. 
• If you are unable to send an email to the SMTP server, review any error 

messages you receive. It is possible the SMTP server address is valid, 
but the authentication credentials are not valid.

FTP authentication Scanning to FTP sites may require the configuration of two sets of 
credentials: proxy credentials and FTP server credentials.
If your network environment requires the use of a proxy server to access 
external FTP sites, you need to configure appropriate proxy credentials 
that include username, password and authentication method. Proxy 
authentication methods include: User after log on and None. You may 
also need to configure a username and password to access the FTP 
server. The Scan Station also supports anonymous FTP. 

Corrupted configuration file If your Scan Station’s configuration file becomes corrupt, you may 
experience the following:
•  A blank screen is displayed instead of the destinations and groups that 

you previously setup.
• A USB flash drive with a new administrative configuration file is 

inserted into the Scan Station and the new settings are not recognized.
• A USB flash drive with an administrative configuration file is inserted 

into the Scan Station and the Settings mode icons are not all properly 
displayed.

If you experience any of these issues, it is likely that your configuration 
file on the Scan Station is corrupt. If you are running version 1.6.x.x or 
greater, the corrupt configuration file will automatically be replaced with a 
blank configuration file that contains only default settings. In this case, 
you will have to reconfigure the Scan Station with a backup copy of a 
configuration file. 
If you are running version 1.5.x.x, call Kodak Support.
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Scan to Network Share Issues Possible Solution
Unable to scan to network folder Using another Windows XP or 2000 PC on your network, ping the 

NETBIOS computer name of the Share destination. For example, if your 
destination is \\Servername\Sharename, ping Servername. 

• If you get a reply to your ping, NETBIOS name resolution is working 
and the problem may be with the share name or permissions to the 
share.

• If you do not get a ping, NETBIOS name resolution is not working. If 
you know you have a valid shared folder, you can use either the IP 
address or, in some cases, the Fully Qualified Domain Name in place 
of the server name. For example, if the IP address of the computer that 
hosts the share is 100.100.100.1 and the Fully Qualified Domain Name 
is server.company.com you could trying using either: 
\\100.100.100.1\Sharename or \\server.company.com\sharename  
One of these two usually works in place of NETBIOS names in the 
destination address for the share.

• If NETBIOS name resolution is not working and it is your only choice 
for defining network paths, ask your network administrator about 
changing your router’s configuration. Many organizations block TCP/IP 
traffic over ports 137 and 139, which are the TCP ports Microsoft uses 
for NETBIOS over TCP/IP.  When these ports are blocked, you will not 
be able to resolve a NETBIOS name if the path to the destination 
address crosses router (i.e., sub-net) boundaries.

• Using another Windows XP or 2000 PC  on your network, open 
Windows Explorer and map a network drive to 
\\Servername\Sharename. If this does not work, check the Permissions 
of the shared folder on the host computer. Make sure either Everyone 
or the user account for the Scan Station has Read and Write 
permissions to the shared folder.

• To verify a network shared folder is accessible on your network, from 
another PC on your network, click Start>Run… In the Open: field, type 
in the server name (e.g., \\servername) and click OK.  If the server is 
accessible, then all available shared resources will be displayed. 
Select one of these shared resources to verify it is active. If not, correct 
the Permissions on the shared folder before trying to access the folder 
from the Scan Station.
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Fax Issues Possible Solution
Fax - General If your Scan Station fails to send or receive a fax, be sure that:

• an external modem is connected.
• a dedicated working telephone line has been attached to the modem.
• fax is properly configured for your country. See the section entitled, “Fax 

settings” in Chapter 3 and select Modem Country Code to select your 
country.

• In the case of failure to send a fax, an email describing the error will be 
sent to the user (the person who sent the fax). If the user has not 
configured their email address, the email will be sent to the administrator. 
A log file will be created in all cases.  

• If errors persist, see the section entitled, “Saving error log files” in this 
chapter for more information.

Outgoing Fax If your Scan Station fails to send a fax, be sure that:
• fhe recipient fax number is correct.
• fhe number you need to dial to access an outside line is correct (e.g., 9). 

See the section entitled, “Fax settings” in Chapter 3 (Outside Line Prefix) 
for more information.

• Verify the status of the fax recipient’s fax number.
Outgoing Fax If your Scan Station fails to search for a fax recipient, be sure that:

• the recipient’s name (partial or full) is correct.
• fax is properly configured. See the section entitled, “Fax settings” in 

Chapter 3. Obtain the LDAP Fax Field Tag from your email administrator. 
Select LDAP Fax Field Tag from the Fax Settings screen and enter this 
information using the virtual keyboard. For example, 
“facsimiletelephonenumber”.

Incoming Fax If your Scan Station is not receiving faxes, be sure that:
• the recipient fax number is correct.
• fax is properly configured. See the section entitled, “Fax settings” in 

Chapter 3. Be sure that one of the options on the Incoming Fax Settings 
screen is configured to allow delivery of incoming faxes (Incoming Fax 
Folder and/or Incoming Fax Printer) and be sure that the Scan Station 
has access to the configured destinations.

• the Receive Fax option is checked on the Incoming Fax Settings screen.
• Refer the “Network authentication issues” in Chapter 5 to resolve other 

issues.
Scan Station Error Possible Solution

Unexpected error while trying to 
update the date settings.

Displayed when trying to change the Scan Station date setting.
•  If this message is displayed, contact Kodak Support.

Unexpected error while trying to 
update the time settings.

Displayed when trying to change the Scan Station time setting. 
• If this message is displayed, contact Kodak Support.

Paper jam.
Please clear the paper path and 
rescan.

A document is lodged in the paper path. 
• Open the Scan Station cover and remove the paper from the paper path.

Please wait, lamps are warming up. • Informational message. Wait until the lamps are completely warmed and 
try again.

Attachment is too large. The email attachment is larger than the email server allows.
•  Try resending using a lower resolution or lower compression quality 

(Good instead of Best).
• Reduce the number of pages scanned.
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Destination not found. Displayed when trying to deliver scanned documents to destinations.
• Verify that the selected destination is correct.
• If scanning to a network, be sure the folder path is correct.

E-mail server error (xxx). Displayed when trying to deliver scanned images to an email server and the 
server returns an error. Additional error codes will appear at the end of the 
string.
• Verify that the SMTP address is correct. If problem persists, contact your 

system administrator.
E-mail server not found. Displayed when trying to deliver scanned images to an email server and the 

email server is not communicating.
• Verify that the SMTP address is correct. If problem persists, contact your 

system administrator.
File is too large. There is insufficient space on either the network or flash drive folder.

•  Try resending using a lower resolution or lower compression quality 
(Good instead of Best).

• Reduce the number of pages scanned. 
• Delete older files on the network folder or flash drive to free up disk space.
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Displayed Error Possible Solution
Flash driver error (xxx). Displayed when the Scan Station cannot copy files to a flash drive. 

Additional error codes will appear at the end of the string.
• Verify that the format of the flash drive is correct. Reformat if necessary.

The flash drive was not found. Displayed if the flash drive was removed before the final delivery of the 
scanned image.
• Verify that the flash drive is properly inserted in the USB port. Remove and 

reinsert it if necessary.
FTP server/folder not found. Displayed if the FTP server or folder became inaccessible before the final 

delivery of the scanned image.
• Verify that the path on the FTP server exists. Check the address to the 

FTP site to make sure it is entered correctly.
FTP error. General error communicating with an FTP server.

•  Verify that the proxy settings are entered correctly (if needed).
General error (xxx). Displayed when no other error information is available. Additional error 

codes will appear at the end of the string.
•  If this message is displayed, contact Kodak Support.

Insufficient rights. The Scan Station lacks sufficient rights to access a network resource such 
as a print server or network folder.
• Verify that the Scan Station credentials (username, password and domain 

name) are correct.
• Contact the network administrator to verify the account is valid and not 

“locked out”.
• Verify that the account password has not expired.

Network drive error (xxx) General error trying to copy scanned documents to a network folder. 
Additional error codes will appear at the end of the string.
• Verify the path to the selected network folder exists and the Scan Station 

user account and password have sufficient credentials to access the 
network shared folder.

Network drive not found. Displayed if the network folder became inaccessible before the final delivery 
of the scanned document.
• Verify the path to the selected network folder exists and the Scan Station 

user account and password have sufficient credentials to access the 
network shared folder.

Printer error (xxx). Displayed when trying to access a printer. Additional error code will appear 
at the end of the string.
• Contact the network administrator to verify that the printer is still online.
• Check that the Scan Station credentials are sufficient to access network 

printers on your network domain.
Printer not found. Displayed if the network printer became inaccessible before the final 

delivery of the scanning document.
• Contact the network administrator to verify that the printer is still online.
• Check that the Scan Station credentials are sufficient to access network 

printers on your network domain.
Unexpected error
Please refer to the User’s Guide for 
more information.

Displayed when no other error information is available, but an error 
occurred.
• If this message is displayed, contact Kodak Support.
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Displayed Error Possible Solution
KDSEmbeddedbase.exe error on 
display

Indicates an invalid TCP/IP address, such as a DHCP setting is used on a 
FIXED TCP/IP network or an incorrectly configured TCP/IP address is 
syntaxed incorrectly.
• Disconnect the Ethernet cable connection from the Scan Station to the 

premise wiring/hub/or router, and then reboot the scanner. Correct the 
TCP/IP address information and reconnect and reboot the Scan Station.
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8 Glossary

Authentication credentials — a username, password and optional 
network domain name that grants the Scan Station access to network 
resources. 

Challenge Response (CRAM-MD5) — an encryption algorithm used 
for authenticating access to an email server. 

Configuration file — an encrypted .xml file containing all the settings 
for the device. Basically, a configuration file tells the Scan Station who it 
is, how to scan and where to send the digital files. 

Configuration Organizer — the software used by users of the Kodak 
Scan Station 100 to configure the Scan Station and to create personal 
settings that are typically saved to a USB flash drive. 

DHCP (Domain Host Control Protocol) — a network protocol that 
dynamically assigns network addresses (IP addresses) to computers 
and other network devices.

FQDN (Fully Qualified Domain Name) — a human-readable name 
linked to the IP address of a computer. It includes both the computer’s 
host name and domain name.

FTP (File Transfer Protocol) — a standard Internet protocol which is the 
simplest way to exchange files between computers on the Internet. Like 
the Hypertext Transfer Protocol (HTTP), which transfers displayable 
Web pages and related files, and the Simple Mail Transfer Protocol 
(SMTP), which transfers email, FTP is an application protocol that uses 
the Internet's TCP/IP protocols. FTP is commonly used to transfer Web 
page files from their creator to the computer that acts as their server for 
everyone on the Internet. It is also commonly used to download 
programs and other files to your computer from other servers.

IP address (Internet Protocol) — used to reference computers on a 
network. Addresses presented in a universal format of four, three-digit 
numeric values separated by a period (e.g., 192.168.1.1).

MIME (Multipurpose Internet Mail Extensions) — the standard for 
attaching non-text files to Internet mail messages. These files include 
spreadsheets, formatted word-processor documents, graphics and 
sound files. The MIME standard defines the type of file being sent and 
what should be done to convert it back into its original form.

NETBIOS (Network Basic Input Output System) — an API that allows 
applications on different computers to communicate within a local area 
network. Created by IBM and later adopted by Microsoft, NETBIOS is 
used in most physical topologies and is a staple of Windows NT 
networks. A broadcast “protocol” that does not support a routing 
mechanism, NETBIOS is often carried over other protocols to allow its 
continued use in larger modern (routed) networks. 
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NETBIOS Name — also known as the computer name in Microsoft 
Windows, the NETBIOS name is a unique name for the device. Only 15 
characters can be used. 

NT Domain Server — a Microsoft Windows based server that defines 
a network domain. A network domain defines a grouping of computers 
and computer resources such as; printers, mail servers and file servers. 

NTLM — an authentication algorithm for accessing an email server.

Ping — typically a command line program that allows a user or 
administrator to see if a specific device is active and responsive on the 
network. For example, ping 127.0.0.1 will test to see if a local computer 
(the one you are using) can respond to a network request. 

Proxy Server — acts as an intermediary between a workstation user 
and the Internet so that the enterprise can ensure security, 
administrative control, and caching service. A proxy server is 
associated with or part of a gateway server that separates the 
enterprise network from the outside network and a firewall server that 
protects the enterprise network from outside intrusion.

Remote Configuration — the ability to configure network devices 
(Scan Station 100) from a remote location on the network. 

Router — a device that allows multiple computers and devices to 
connect to a local area network. A router can also be one of many 
routers that comprise a wide area network (WAN). 

SMTP (Simple Mail Transfer Protocol) — is protocol used in sending 
and receiving email. However, since it is limited in its ability to queue 
messages at the receiving end, it is usually used with one of two other 
protocols, POP3 or IMAP, that allows the user to save messages in a 
server mailbox and download them periodically from the server.

TCP/IP (Transmission Control Protocol / Internet Protocol) — a suite of 
protocols tailored to specific needs for advanced networking. Named 
after TCP and IP, the first of the many protocols in the suite. TCP/IP 
forms the basic standard for communication over the Internet.

TCP Port — special number in the header of a network data packet, 
TCP ports are used to map data to computer processes or applications. 
For example, a server receiving incoming TCP data packets with a 
number of 21 in the header will normally map that data to the FTP 
process running on the server (21 is the standard port for initiating an 
FTP session with a client). 

UNC (Universal Naming Convention) — a standard for identifying 
servers, printers and other resources in a network, a UNC path uses 
double slashes or backslashes to precede the name of the computer 
and a single slash to precede the name of the resource being 
accessed. In Windows operating systems, the UNC name format is: 
\\servername\sharename\path\filename 

Workgroup — a Microsoft network mechanism for grouping multiple 
computers and computer resources without the use of an actual 
network domain.
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Appendix A Specifications

Recommended daily 
volume

Up to 1000 pages per day

Output resolutions 75, 100, 150, 200, 240, 300, 400 and 600 dpi
Illumination Fluorescent (cold cathode)
Throughput speeds 
(portrait, letter-size)

Black and white/grayscale: up to 25 ppm/50 ipm at 200 dpi
Color: up to 25 ppm/40 ipm at 200 dpi

Scanning technology Dual CCD, 600 dpi optical resolution
Capture bit depth is 48 bits (16 x 3)
Color output bit depth is 24 bits (8 x 3)
Grayscale output bit depth is 256 levels (8-bit)

Optical resolution 75, 100, 150, 200, 240, 300, 400 and 600 dpi
Connectivity 10/100 Base T
Network Protocols TCP/IP, SMB, SMTP, DHCP (or static), Network Domain Authentication
Control Panel Touch screen, 18-bit color, 640 x 480 resolution
On-board processor, 
memory, hard drive

Celeron D 2.4 GHz, 1 GB RAM, 40 GB hard drive

Maximum document size 215 x 863 mm (8.5 x 34 in.) - may be restricted at certain resolutions
Minimum document size Single-sheet feeding (with Special Document Feeder): 50 x 87.5 mm (2 x 3.5 in.)

Multiple-sheet feeding: 87.5 x 125 mm (3 x 5 in.)
Paper thickness and 
weight

52 - 105 g/m2 (14 - 28 lb.) paper

Feeder Up to 50 sheets of 75 g/m2 (20 lb.) paper. Special Document Feeder included for 
front-feed, front-return single document feeding.

Recommended PC 
configuration

Pentium IV, 300 MHz or higher, 512 MB RAM, running Windows XP or 2000

Recommended portable 
USB drive specs

USB 2.0, minimum size for configuration: 32 MB, 
minimum size for storing images/files: 128 MB

Imaging features Perfect Page scanning, deskew, auto crop
File Format Output Single- and multi-page TIFF, JPEG, and searchable PDF
Output methods Scan to network share, scan to print, scan to email, scan to portable USB flash drive
Power consumption Standby: <75 Watts; Operating: <95 Watts
Dimensions Height: 28.7 cm / 11.3 in. 

Width: 59.7 cm / 23.5 in.
Depth: 33.8 cm / 13.3 in.

Weight 18.1 kg (40 lbs.)
Operating Temperature 10°C to 35°C (50°F to 95°F)
Humidity 10 to 85%
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Appendix B Warranty - US and Canada only 

Congratulations on the purchase of a Kodak Scan Station 100, Kodak 
Scan Station 100 Plus or Kodak Scan Station 120EX. Kodak Scan 
Stations are designed to provide end users with the highest 
performance and reliability. All Kodak Scan Stations are covered by the 
following Limited Warranty.

Limited warranty for 
Kodak Scan Stations

Eastman Kodak Company provides the following Limited Warranty on 
Kodak Scan Stations (excluding spare parts and consumables) 
distributed by Kodak or through Kodak’s authorized distribution 
channels:

Kodak warrants that a Kodak Scan Station, from the time of sale 
through the Limited Warranty period applicable to the Product, will be 
free of defects in materials or workmanship and will conform to the 
performance specifications applicable for the particular Kodak Scan 
Station.

All Kodak Scan Stations are subject to the Warranty Exclusions 
described below. A Kodak Scan Station found to be defective or which 
does not conform to the product specifications will be repaired or 
replaced with new or refurbished product at Kodak’s option.

Purchasers may determine the applicable Limited Warranty period for 
the Kodak Scan Stations purchased by calling (800) 822-1414, or by 
visiting: http: www.Kodak.com/go/docimaging or by reviewing the 
Limited Warranty Summary Card enclosed with the Kodak Scan 
Station.

Proof of purchase is required to demonstrate eligibility for warranty 
service.
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Warranty exclusions Kodak’s Limited Warranty does not apply to a Kodak Scan Station that 
has been subjected to physical damage after purchase, caused, for 
example, by casualty, accident, acts of God or transportation, including 
(a) by a failure to properly package and ship the Scan Station back to 
Kodak for warranty service in accordance with Kodak’s then current 
Packaging and Shipping Guidelines, including failure to replace the 
shipping restraint prior to shipping, or by a failure to remove the 
shipping restraint prior to use; (b) resulting from the user’s installation, 
system integration, programming, re-installation of user operating 
systems or applications software, systems engineering, relocation, 
reconstruction of data, or removal of the product or any component 
(including breakage of a connector, cover, glass, pins, or seal); (c) from 
service, modification or repair not performed by Kodak or a service 
provider authorized by Kodak or by tampering, use of counterfeit or 
other non-Kodak components, assemblies, accessories, or modules; 
(d) by misuse, unreasonable handling or maintenance, mistreatment, 
operator error, failure to provide proper supervision or maintenance, 
including use of cleaning products or other accessories not approved 
by Kodak or use in contravention of recommended procedures or 
specifications; (e) by environmental conditions (such as excessive heat 
or other unsuitable physical operating environment), corrosion, 
staining, electrical work external to the product or failure to provide 
electrostatic discharge (ESD) protection; (f) by failure to install firmware 
updates or releases available for the product and (g) by such other 
supplemental exclusions published from time to time online at http: 
www.Kodak.com/go/docimaging or by calling (800) 822-1414.

Kodak provides no Limited Warranty for products purchased from 
countries other than the United States. Purchasers of products from 
foreign distribution channels must seek warranty coverage, if any, 
through the original source of purchase.

Kodak provides no Limited Warranty for products that are purchased as 
part of a third party manufacturer’s product, computer system or other 
electronic device.

Any warranty for these products is provided by the OEM (Original 
Equipment Manufacturer) as part of that manufacturer’s product or 
system.

The replacement product assumes the remainder of the Limited 
Warranty period applicable to the defective product or thirty (30) days, 
whichever is longer.
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Installation Warning 
and Disclaimer

KODAK WILL NOT BE RESPONSIBLE FOR ANY CONSEQUENTIAL 
OR INCIDENTAL DAMAGES RESULTING FROM THE SALE, 
INSTALLATION, USE, SERVICING OR IMPROPER FUNCTIONING 
OF THIS PRODUCT, REGARDLESS OF THE CAUSE. SUCH 
DAMAGES FOR WHICH KODAK WILL NOT BE RESPONSIBLE, 
INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF REVENUE OR 
PROFIT, LOSS OF DATA, DOWNTIME COSTS, LOSS OF USE OF 
THE PRODUCT, COST OF ANY SUBSTITUTE PRODUCT, 
FACILITIES OR SERVICES OR CLAIMS OF CUSTOMERS FOR 
SUCH DAMAGES.

If there is any conflict between other sections of this appendix and the 
Limited Warranty, the terms of the Limited Warranty prevail.

How to obtain limited 
warranty service 

Kodak Scan Stations are supplied with information on unpacking, 
setup, installation and operation. Careful reading of the User’s Guide 
will answer most of the technical questions the end user might have 
regarding proper installation, operation and maintenance of the 
product. However, should additional technical support be required, you 
may visit our website at: http: www.Kodak.com/go/docimaging or 
contact:

Kodak’s Response Center 
(800) 822-1414

The Response Center is available Monday – Friday (excluding Kodak 
holidays) 8 a.m. to 5 p.m. EST.

Before placing the call, the eligible purchaser should have the Kodak 
Scan Station model number, part number, serial number and proof of 
purchase available. The eligible purchaser should also be prepared to 
provide a description of the problem.

Response Center personnel will assist the end user in resolving the 
problem over the phone. The end user may be asked to run some 
simple, self-diagnostic tests and report the resulting status and error 
code messages. This will assist the Response Center in determining if 
the problem is the Kodak Scan Station or another component and if the 
problem can be resolved over the phone. If the Response Center 
determines a hardware problem exists that is covered either under the 
Limited Warranty or a purchased Maintenance Agreement, a Return 
Material Authorization Number (RMA) will be assigned as needed, a 
service request will be initiated and repair or replacement procedures 
will follow.
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Packaging and 
shipping guidelines

Purchaser must ship all warranty returns in a method that guarantees 
full protection of the product from shipping damage. Failure to do so will 
void the Kodak Scan Station warranty. Kodak advises the purchaser to 
keep the original box and packing materials for storing or shipping. 
Kodak is not responsible for issues related to shipping damage. The 
purchaser must return only the Kodak Scan Station. Prior to shipment, 
purchaser must remove and retain all “add-on” items, (i.e. adapters, 
cables, software, manuals, etc.). Kodak accepts no responsibility for 
these items and they will not be returned with the repaired or 
replacement Kodak Scan Station. All products should be returned to 
Kodak in the original shipping container, or an authorized packaging 
box for the units being returned. Purchaser must install the shipping 
restraint before the Kodak Scan Station is shipped. When the original 
packaging is not available, contact Kodak’s Response Center at (800) 
822-1414 for part numbers and replacement packaging ordering 
information.

Return procedure Eligible purchasers seeking services for Kodak Scan Stations covered 
under this Limited Warranty must obtain a Return Material Authorization 
number (“RMA”) by calling (800) 822-1414 and within ten (10) business 
days from the date of issuance of the RMA must return the Kodak Scan 
Station to the address designated in the RMA at the end user’s own 
expense and risk, in compliance with Kodak’s current Packaging and 
Shipping Guidelines.

Any defective products or parts replaced by Kodak become the 
property of Kodak.

Customer 
responsibility

BY REQUESTING SERVICE, THE ELIGIBLE PURCHASER 
ACKNOWLEDGES THE TERMS OF THE LIMITED WARRANTY, 
INCLUDING THE DISCLAIMER AND LIMITATION OF LIABILITY 
PROVISIONS. PRIOR TO SEEKING SERVICE, THE END USER 
MUST BACK-UP ANY DATA OR FILES THAT MAY BECOME 
DAMAGED OR LOST. KODAK IS, WITHOUT LIMITATION, NOT 
RESPONSIBLE FOR LOST OR DAMAGED DATA OR FILES.

Warranty Service 
descriptions 

Eastman Kodak Company (Kodak) offers a range of service programs 
to support its Limited Warranty and to assist with the use and care of 
the Kodak Scan Station (“Service Methods”). A Kodak Scan Station 
represents an important investment. Kodak Scan Stations provide the 
productivity needed to stay competitive. The sudden loss of this 
productivity, even temporarily, could seriously affect the ability to meet 
commitments. Downtime can be very expensive, not just in the cost of 
the repair but also in time lost. To help alleviate these problems, Kodak 
may use one of the service methods listed below, depending upon 
product type, in providing service under its Limited Warranty.
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Included with selected Kodak Scan Station is a Limited Warranty 
Registration card and a Limited Warranty Summary card. The Limited 
Warranty Summary card is specific by model. The Limited Warranty 
Summary card contains important warranty information, including the 
model number and the Limited Warranty. Refer to the Limited Warranty 
Summary card to determine the available Service Methods applicable 
to the particular Kodak Scan Station.

If the Limited Warranty Registration card or Limited Warranty Summary 
card cannot be located, additional information may be obtained about 
the product, including updated warranty and service program 
information and restrictions, online at: http: www.Kodak.com/go/
docimaging or by phone at (800) 822-1414.

To avoid service delays, Kodak urges end users to complete and return 
the enclosed Limited Warranty Registration Card at the first opportunity. 
If you cannot locate the Limited Warranty Registration card, you may 
register online at: http: www.Kodak.com/go/docimaging or by phone at 
(800) 822-1414.

Kodak also provides a variety of service programs that may be 
purchased to assist with the use and care of the Kodak Scan Station. 

Kodak is committed to providing its customers with quality, 
performance, reliability and service under the Limited Warranty.

On-site service For the selected Kodak Scan Station, and after the Response Center 
verifies a hardware problem, a service call will be opened and logged. 
An Kodak Field Engineer will be dispatched to the product location to 
perform repair service if the product is located within the contiguous 
forty-eight (48) United States, in certain areas of Alaska and Hawaii, 
and if there are no security, safety or physical requirements that would 
restrict the Field Engineer’s access to the Scan Station. For additional 
information on service areas, please visit our website at: 
www.Kodak.com/go/docimaging. On-Site Service will be provided 
between the hours of 8 a.m. and 5 p.m. local time, Monday through 
Friday (excluding Kodak holidays).

AUR AUR may be one of the easiest and most comprehensive service 
offerings in the industry. In the unlikely event of a product defect, for 
eligible purchasers of certain Kodak Scan Stations, Kodak will replace 
that product within two business days.
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The AUR provides advance replacement on specific failed or broken 
Kodak Scan Station. To be eligible to take advantage of the AUR, the 
eligible purchaser must obtain an RMA number, sign an Advance 
Replacement Agreement and provide a credit card deposit to secure 
the replacement product. The RMA number should be kept in the event 
that the status of the replacement product needs to be checked. The 
eligible purchaser will be asked for the address where the replacement 
product is to be shipped. The eligible purchaser will also be faxed 
packing and shipping instructions for the malfunctioning product. The 
eligible purchaser will then receive a replacement product within 2 
business days after the service call initiation and Kodak’s receipt of the 
signed agreement. The malfunctioning product must be received by 
Kodak within ten (10) days of the end user’s receipt of the replacement 
product or the end user’s credit card will be charged the list price of the 
replacement product. Shipment of replacement Imaging Product will be 
made at Kodak’s expense and choice of freight carrier. Shipments not 
made under Kodak’s directions and choice of freight carrier may void 
the Limited Warranty.

Before the product is returned to Kodak, be sure to remove all options 
and accessories (which include power cord, documentation, etc.) that 
are not covered by the Limited Warranty. The box and packaging in 
which the replacement product was shipped must be used to return the 
malfunctioning product. If the malfunctioning product is not returned in 
the box and packaging in which the replacement product was shipped 
the Limited Warranty may be voided. The Return Material Authorization 
Number (“RMA”) must be clearly marked on the outside of the box to 
ensure proper receipt and credit of the defective product.

Depot service If the Kodak Scan Station is not eligible for Advance Exchange or On-
Site Service, an eligible purchaser may utilize our Depot Repair 
Service. The eligible purchaser will be instructed to ship the product to 
the nearest authorized Depot Repair Center. Product must be shipped 
at the eligible purchaser’s risk and expense to the repair center. Before 
the product is returned to the repair center, be sure to remove all 
options and accessories (which include power cord, documentation, 
etc.) not covered by the Limited Warranty. All products should be 
returned to Kodak in the original shipping container, or in a 
recommended packing box. The Kodak Scan Station must have the 
shipping restraint installed before it is shipped. When the original 
packaging is not available, contact Kodak’s Response Center at (800) 
822-1414, for ordering information. Eligible purchasers seeking 
services for Kodak Scan Stations must obtain a Return Material 
Authorization number (“RMA”) by calling (800) 822-1414, and within ten 
(10) business days from the date of issuance of the RMA must return 
the Kodak Scan Station to the address designated in the RMA at the 
end user’s own expense and risk. The Return Material Authorization 
Number (“RMA”) must be clearly marked on the outside of the box to 
ensure proper receipt and credit of the defective product.

Upon receipt of the product, the repair center will repair product within 
ten (10) business days. The repaired product will be shipped back two-
day express mail at no expense to the eligible purchaser.

Download from Www.Somanuals.com. All Manuals Search And Download.



A-61588  July 2008 B-7

Important restrictions Eligibility: The Advance Exchange Program and the Depot Service are 
available to eligible purchasers in the fifty (50) United States, and On-
Site Service is available in the contiguous forty-eight (48) states and in 
certain areas of Alaska and Hawaii for products purchased from 
authorized distributors of Kodak. The Kodak Scan Station will be 
ineligible for any service under warranty if the product falls under any of 
Kodak’s then-current Warranty Exclusions, including a purchaser’s 
failure to return defective products to Kodak in compliance with Kodak’s 
then current Packaging and Shipping Guidelines. Persons are only 
considered “eligible purchasers” or “end users” if they originally 
purchased the Kodak Scan Station for their own personal or business 
use, and not for resale.

Consumables: Consumables are items that wear out under normal 
use and must be replaced by the end user as needed. Consumables, 
supplies, other expendable items and those items identified as being 
the user’s responsibility in the User’s Guide are not covered under the 
Limited Warranty.

If any of the above excluded parts or services are required, they may be 
available through an authorized service provider at their hourly rates 
and at terms then in effect.

Any defective products or parts replaced by Kodak become the 
property of Kodak.

Contacting Kodak For Information on Kodak Scanners:
Website: www.Kodak.com/go/docimaging

For U.S. Service, Repair and Technical Assistance by Telephone:
Telephone technical support is available Monday-Friday between the 
hours of 5 a.m. to 5 p.m. excluding Kodak holidays. Phone: (800) 822-
1414

For Technical Documentation and FAQ’s available 24 hours a day:
Website: www.Kodak.com/go/docimaging

For Service Program Information
Website: www.Kodak.com/go/disupportservices
Phone: (800) 822-1414
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